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Welcome to MicroGDS�11.

MicroGDS is a powerful, computer-aided design and draughting system
that makes it easy to transfer your creative and imaginative ideas into
two-dimensional and three-dimensional drawings and models.

MicroGDS is a registered trademark of Informatix Inc.

Informatix offer two MicroGDS products: MicroGDS Collaboration
and MicroGDS Entry Level. Both products share a comprehensive set
of features for meeting the needs of today’s CAD users, including:

� the ability to draw to any scale using real-world measurements

� an extensive set of styles and drawing effects to make your drawings
clear and attractive

� easy to use methods for creating and modifying data
� flexible and powerful tools for moving, editing, and deleting objects

� 3D geometry generation from 2D drawings

� the ability to work in multi-user mode so that a number of users can
access the same project data simultaneously
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� simple and effective techniques for exchanging data with other
Windows software

� the ability to read and write data in other formats, including XML,
DXF and DWG

� the ability to publish to numerous other formats, including PDF,
PNG, and DWF

� extensive customization facilities

You can also use MicroGDS modelling with Piranesi� to produce
exhibition-quality drawings. Piranesi is a unique three-dimensional
paint package that offers sophisticated painting techniques enabling you
to express your ideas using a whole range of artistic effects.

Piranesi is a product of Informatix Inc. You can find the Piranesi
homepage at www.piranesi.co.uk

It is recommended that you periodically check the Informatix website
for new product information, updates, and free downloads. You can find
the MicroGDS homepage at www.microgds.co.uk
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MicroGDS Collaboration offers a full complement of features,
including the capability to work in a multi-user environment.
MicroGDS Collaboration also provides full 3D solid and surface
modelling, plus a sophisticated, photo-realistic renderer.

This product is ideal for users who wish to generate high quality
visualizations of 3D models, and work in both multi-user and
single-user environments.
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MicroGDS Entry Level offers similar features to MicroGDS
Collaboration, but has a reduced set of 3D functions and rendering
capabilities. This product is tailored for users who wish to work in both
multi-user and single-user environments, but require only basic
visualization capabilities.
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The MicroGDS website is your online technical resource centre. You
can read the latest MicroGDS reviews, access all the product
information, download applications and tools, and access the
MicroGDS Gallery and User Forum. Visit the MicroGDS Gallery to
view a range of example images created using MicroGDS. The User
Forum lets you get in touch with other MicroGDS users around the
world. Use it to share your thoughts, ask questions, provide answers,
share images, and exchange tips and techniques. You can find the
official MicroGDS website at www.microgds.co.uk

You can also access the website directly from MicroGDS by clicking
MicroGDS Homepage on the MicroGDS Help menu.

It is recommended that you periodically check the MicroGDS website
for new product information, updates, and free downloads.

���	�����0�
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The MicroGDS version number is shown on the MicroGDS title bar.
You can check the MicroGDS website online to see if there are updates
to your copy of MicroGDS.

When an update or new version becomes available on the website, you
can choose to download and install it.

To check for updates, click Check for Updates on the MicroGDS Help
menu, then follow the instructions on the screen.
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This user guide presents selected concepts and procedures to enable you
to begin working with MicroGDS. The guide includes information
about creating and placing graphics, working with styles, working with
other file formats, and customizing MicroGDS.

It also contains information on working in a multi-user environment and
the advanced solid and rendering features in MicroGDS Collaboration.

�
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The guide is arranged in two parts:

� Part One: Working with MicroGDS 11
Explains the concepts and features that are applicable to both
MicroGDS products. It also describes how to work in a multi-user
environment.

� Part Two: Advanced 3D and rendering

Describes the advanced solid and rendering features available in
MicroGDS Collaboration.
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Informatix provides documentation and services for learning how to use
MicroGDS and for solving problems.
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The MicroGDS documentation consists of a user guide and a
comprehensive online Help system. The user guide is provided in PDF
format. 

� What’s new in MicroGDS 11
This document provides information on new and enhanced features
in MicroGDS 11. The document is provided in PDF format which
you can find on the MicroGDS website at www.microgds.co.uk

� Using MicroGDS

The user guide describes the fundamental concepts and how to use
the features in MicroGDS.

For full details of all the commands available in MicroGDS, refer to
the online Help.
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� MicroGDS Help

MicroGDS provides extensive online Help. Details of every
command and dialog box are included, along with procedures for
completing each task.

4		���������#����7�#�

To access the MicroGDS online Help system and use the full facilities
of Microsoft HTML Help, Microsoft Internet Explorer must be installed
on your computer.

� 3������������#����7�#���-���&

1 On the MicroGDS Help menu, click Help Topics.

The main Help window is displayed, showing the topic Overview of
MicroGDS.

2 Click the Contents, Index, Search, or Favorites tab to choose how
you would like to navigate to the required help topic.

3 To display help on a topic, double-click the topic name.

� 3������#�-�	����"�1�������'����#�

1 Press Shift+F1, or on the MicroGDS Help menu, click What’s This?

A question mark is attached to the mouse pointer.

2 Click the command or toolbar button you want help on.

� 3������#�-���#���������	�
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� press F1, or click the Help button on a dialog box

3
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Informatix provides training courses that are designed to teach you how
to plan and draw in MicroGDS. The courses are structured to cover
basic foundation training, 3D, and advanced use. Please contact
Informatix for more information.
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1 On the taskbar, click the Start button and point to Programs.

2 Point to the folder that contains MicroGDS, then click MicroGDS.

You can also start MicroGDS by double-clicking a MicroGDS desktop
shortcut, or double-clicking one of the following MicroGDS file types:

� .MAN single-user document

� .MTF single-user template

� .STY style file

� .CV7 font file

� .CPJ multi-user project
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Many commands require you to enter positions. To help you,
MicroGDS displays hints, prompts, the status of specific items, and
coordinate positions at the bottom of the MicroGDS window. For
example:

Information is shown from left-to-right about:

� the current command

Shows a summary of the command under the mouse pointer or the
action required to complete the next step in the command.

� the pointer position

Shows the current pointer position—in the current units and decimal
places—together with the nearest snapcode. This information is
dynamically updated as you move the mouse pointer across a
drawing. You can set your preferences to show only the last hit
position if you prefer. For details about setting preferences, see
page 22. For information about each individual preference, refer to
Help.

� the status of the Z=0 facility

The Z=0 button enables you to force graphics to be drawn on the
XY plane. For details about using the Z=0 facility, refer to Help.

� the status of the SETEDIT facility

The SETEDIT button enables you to set editing restrictions to
temporarily exclude graphics from being edited. For more details,
see Chapter 3, Working with primitives and objects.

� the status of hover highlighting

The Hover Highlight button provides feedback about the graphics
directly beneath the mouse pointer. Details are given in Chapter 3,
Working with primitives and objects.

� an animation when drawing is in progress

� the status of the grid

A grid can assist you when you are drawing and placing graphics.
When a grid is defined, you can switch it on and off using the Grid
button.

More details about the grid are given in Chapter 5, Entering
positions.









22 Using MicroGDS 11

���������
�0�
��	��
You can customize MicroGDS by setting up a number of personal
preferences. Initially, all preferences are preset to the default MicroGDS
settings. You can modify settings using either the Preferences dialog
box or the Preference Files Editor. The Preferences dialog box gives
access only to your personal settings whereas the Preference Files
Editor may let you modify settings at other levels. For example, you
may be able to modify settings for all MicroGDS documents contained
in a specified folder (if you have the relevant access permissions to the
folder).

Note that any change to your personal settings is reflected in both
editors.

All settings are saved to xml files, stored in the appropriate locations.
You can see the location of a settings file in the Preference Files Editor.
For more details about the Preference Files Editor, see Chapter 17,
Customizing MicroGDS.
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� on the File menu, click Preferences

You may find that not all your personal preferences are available to you.
This is because a preference may be set as a policy a higher level.
Where a policy is in place, it cannot be overridden at any lower level.

Changes to your preferences are saved only in memory. To save
changes permanently, save your settings when you exit MicroGDS or
save the settings file using the Preference Files Editor. Note that if you
have any unsaved modified settings when you exit MicroGDS, you will
be prompted to save the changes.

The preferences that you can set up are described in the relevant
sections throughout this guide, and in the Help. Refer also to
Chapter 17, Customizing MicroGDS.
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For more details, see Working with window definitions on page 38 and
Working with multiple views on page 53.

Most graphics in a MicroGDS document have a style assigned. A style
defines the appearance of a graphic. For example, a line primitive has a
linestyle and a text primitives has a charstyle. Some graphics, such as
inserted raster images, do not have a style assigned. Styles that you
create in a document are saved in the MAN file. However, you can also
share standard or common styles by using style files. For details about
style files, see page 25.

You can also use graphics from other files in your documents. For
example, you can insert a raster image from a raster file or link an
object from another single-user document. In MicroGDS, you can set
up aliases to reference the physical locations of files that you want to
use in a document. For more details about aliases, see page 27.

3�&�#����

A template is a document with custom-designed properties and content
which you can use to create other documents. A template can contain
anything that can be stored in a MAN file, such as graphics, styles, and
window definitions. For example, you might create a template to define
a drawing frame or one that includes a company’s logo. Templates are
simply single-user documents that you save with the extension .MTF.
MicroGDS provides ready-made templates (a0.MTF through to
a4.MTF) that you can use.

You may also find it useful to set up a template to reference style files
(described next), or aliases which reference additional files that you can
access.

When you base a new file on a template, the template’s content is
copied to the new document. Templates are used only when you create a
new file; if the template is subsequently updated, existing documents
based on the template are not updated.

If you want to make changes to a template (a .MTF file), you must open
the file using the Open command on the MicroGDS File menu, or drag
the template file into the MicroGDS window. If you double-click the
file in Windows Explorer, a new document based on the template will
be created.
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If you often want the same graphics and styles to be available in new
documents, you can set a default template to be used for all new, blank
files.

You specify the location of your templates on the File Locations tab in
your preferences. Then, when you choose to use a template, MicroGDS
lists any templates that exist in the specified location. For details about
setting your preferences, see Chapter 17, Customizing MicroGDS.

For more details about creating and using templates, refer to Help.

��-#��0�#��

Documents can share styles by using style files. You can create and
access the following types of style file:

Style file name Style type

LINES.STY linestyle

CHARS.STY charstyle

LIGHTS.STY lightstyle

MATLS.STY material

ATTRS.STY mnemonic definition

SCHEMAS.STY schema definition

Only style definitions are saved in a style file. If you create graphics to
help you define the styles, they are discarded when you save and close
the style file.

For single-user documents, you can access style files by specifying their
location on the style search path. For more details, see the following
section Styles and single-user documents.

For multi-user projects, the location of style files is set in the project
database. For more details, see Styles and multi-user projects on
page 27.

You can also access any style files that exist in the location for styles
and fonts, defined in your file location preferences. Any style files that
exist in the specified location are made available to all your documents
(single-user documents and projects). Note that although the style files
in this location are made available, it is the location in which any are
installed with MicroGDS. If you wish to place your own style files in



26 Using MicroGDS 11

this location, first ensure that a style file of its type does not already
exist. If you do store files in this location, be sure to move them before
your MicroGDS installation is updated or repaired, otherwise they may
be lost.
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1 On the File menu, click Preferences.

2 Click the File Locations tab.

3 In the Styles & Fonts box, specify the location in which global style
files (and MicroGDS font files) are located.

By default, the location is set to the Fonts folder in your MicroGDS
installation directory.

Note that your CAD manager can set policies to restrict any of your
preference settings. If the Styles & Fonts box is greyed out, this
indicates that a policy is in place and you cannot change the set
location.

Any changes to your preferences are saved only in memory. To save
changes permanently, save your settings when you exit MicroGDS.
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When you create or modify a style in a single-user document, the style
is saved in the MAN file. These styles are called local styles. However,
you can also access styles in external style files. To do this, you specify
the folder in which the STY files are located on the style search path.
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1 On the File menu, click Style Search Path.

2 In the Edit Search Path dialog box, define the locations of the styles
files (.STY) that are to be referenced by the current document.

The order in which the search paths are listed is important because if
a style name of the same type appears in more than one style file,
MicroGDS uses the first style that it finds.

If changes are later made to any of the styles in a style file, those
changes are reflected in all documents that reference the file.
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If you modify a style from a style file, it becomes a local style in the
current document and is saved in the MAN file. Styles saved in a
document take precedence over styles of the same name in a style file.

For more details about creating and using style files, refer to Help.
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In multi-user projects, all styles are stored in external style files which
are defined in the project database.

If you modify a style from a style file, it becomes a local style and is
saved in the first location on the project’s style search path. For details
about creating multi-user projects, see Chapter 16, Multi-user projects.
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An alias is a name given to a folder so that the path to that folder does
not have to be specified in full. This is similar to using Windows
shortcuts. Mapping a location to an alias is useful when files are moved
in the filing system.

In a single-user document, aliases can be used to reference the locations
of:

� object libraries

Object libraries are MicroGDS MAN files that contain objects you
can insert or link to the current document. For details about objects,
see Chapter 3, Working with primitives and objects.

� raster images

Raster images are image files that you can insert into the current
document. For details about raster files, see Chapter 15, Working
with different file formats.

� reference documents

Reference documents are MicroGDS documents that contain
window definitions that can be used in photos in the current
document. For details about photos, see Chapter 3, Working with
primitives and objects.

� renderer files

Renderer files can be used by materials, lights, and rendering
environments in MicroGDS Collaboration. For details about
rendering, see Part Two: Advanced 3D and rendering.
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Aliases are defined using the Aliases command on the File menu and
are stored in the current document.

Aliases are also used to define the locations for layer and window
definition files, and are set up in the project database. For details, see
Chapter 16, Multi-user projects.
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1 On the File menu, click Aliases.

2 In the Aliases dialog box, define the alias definitions for the current
document:

� to add a new alias, click Add

� to change an existing alias, click Edit
� to remove an alias, click Remove

When you add or change an alias, the Alias Editor is displayed.

3 In the Name box, type the alias name you want to use.

4 In the Location box, specify the physical location to which the alias
refers.

Note that if you map an alias to a network drive, the assignments
will only work for all users who use the same standardised mapping
of drive letters to disks. If you do not use a standardised network
mapping system, you should specify the full network pathname
when you set up alias names.

5 From the Type list, select the alias type you require.

For example:

6 To allow an alias name to be expanded which will give access to any
subfolders below, select the Expandable check box.

7 Click OK to close the Alias Editor, and again to close the Aliases
dialog box.
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The window items are described in Working with windows on page 41.

When you create a single-user document, MicroGDS creates a window
definition (the principal window) and a default view onto the window.
The principal window opens and the default view is shown each time
you open the document. You can create additional window definitions
and saved views as required. For details, see Working with window
definitions on page 38 and Working with multiple views on page 53.
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� on the File menu, click Open, and select the document to open

� or, double-click the .MAN file in Windows Explorer

� or, drag the .MAN file from Windows Explorer into the MicroGDS
window

When the document has loaded, the default view in the principal
window definition opens.

For example:

You can open other MicroGDS documents, such as style files, in the
same way.

You can also open files of other formats, for example, DXF files. For
details, see Chapter 15, Working with different file formats.
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By default, if MicroGDS detects any errors with the document, a
Problems dialog box opens giving details about the error. For example,
an error might indicate that the document contains a link to another
document or file for which MicroGDS cannot find the source or that
fonts used in the document are not installed on the current machine. The
Problems dialog box provides facilities to view and correct the detected
errors. More details are given in the section relevant to the type of data
to which a problem has been found.

Whenever there are unsolved problems in an open document, a yellow

warning triangle is shown on the information bar. You can
double-click the button to open the Problems dialog box.
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When you open a .MAN file, MicroGDS creates a parallel lock file in
the filing system. The lock file has the extension .MA#. Lock files
ensure that only one person can edit the document at one time. The lock
file is removed when the document is closed enabling another person to
open it for editing. While a document is locked, other users can open
the document as read-only.

If you have the Backup option set, on the General tab of your
preferences, and you have made changes to the document since it was
last saved, MicroGDS creates a backup file with the extension .MA$.
When the document is next saved, the backup file is removed.

If a document is not closed correctly, for example, if MicroGDS stops
responding, the lock file and the backup file (if it exists) remain in the
filing system. When you next open the document, MicroGDS prompts
you to first unlock the file. If you unlock the file and a backup file
exists that is more recent than the file at the time it was closed,
MicroGDS displays a second message prompting you to save the file.

If you close the backup file and then open the original file, you cannot
re-open the backup file.

Template files and style files are locked and backed up in the same way.

If the Backup option is not set, a backup file does not exist and any
unsaved changes to a file are lost.
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As you work on a document, you can save the document using either
the same name, or a different name.
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� press Ctrl+S, or on the File menu, click Save MAN File

This command reflects the type of document you are saving. For
example, if you are saving a STY file, the command shows Save
STY File.

If you have not yet saved the document, a Windows Save As dialog
box is displayed. In the Save As dialog box:

a) ensure that the Save as type box shows MicroGDS File (*.MAN)

b) specify the name and location for the document

If you do not include the .MAN extension, MicroGDS adds it
automatically.

c) Click Save.

To save a document to another MicroGDS format, select the appropriate
file type in the Save as type box. You can also export window
definitions to other formats, for example, DXF. For details, see
Chapter 15, Working with different file formats.
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� on the File menu, click Close MAN File

This command reflects the type of document you are closing. For
example, if you are closing a STY file, the command shows Close
STY File.

If the document has not yet been saved, you are prompted to save or
discard it. If you choose to save the document, MicroGDS displays a
Windows Save As dialog box. Save the document as described in the
previous section.

If the document has unsaved changes, you are prompted to save or
discard them.
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Each window definition you open or create is opened in a new window.
You can store multiple window definitions in a single document. This
enables you to work with different parts of a document, and also share
data throughout a document.

For each window definition that you create, MicroGDS also creates an
initial, default view. You can create additional views and move easily
from one to another. For more details, see Working with multiple views
on page 53.

This section describes some of the basic, window definition tasks. For
full details, refer to the appropriate chapters in this guide and also refer
to Help.

�
������� ���� ���0��������

� 3��	
������� ���� ���0�������

1 On the Document Organizer, click the Window Definitions tab:
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2 Click the New Window toolbar button 

Alternatively, use the Window, New command on the File menu.

The window definition opens in a new window. The window title shows
Windown – Viewn, where:

� Windown is the next sequential window definition number within
the current document

� Viewn is the next sequential view number within for the current
window definition

If you do not change the names, MicroGDS stores the window
definition and view with the generated names when you save the
document. Details about renaming window definitions and views are
given later.

When you create a window definition in a multi-user project, you must
save the window to a file. For details, see Chapter 16, Multi-user
projects.
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You can reopen recently-used windows in the document, using the

window’s document menu. You can close the document by clicking 
on the placeholder window or using the Close MAN File command on
the File menu.

Note that if you close a window definition in a multi-user project to
which you have unsaved changes, you are prompted to save the
changes. This is because window definitions in a project are saved in
separate files.
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When you create or open a document, MicroGDS opens a new window.
The rectangle inside a window is where you produce your drawing.
This rectangle is the view extent and is a view onto the drawing sheet.
By default, the axes are shown in the centre of the window. MicroGDS
uses the axes to draw and place graphics. Further details about the axes,
the view extent, and the drawing sheet are given in the next section.

When you have drawn graphics, as you move the mouse pointer around
the view extent you will notice the following:

� if you have hover highlighting switched on, any editable primitive
or object beneath the mouse pointer is highlighted, and information
relating to the graphics is shown in an InfoTip

For more details about hover highlighting, see Chapter 3, Working
with primitives and objects.

� if you have snap guides switched on, MicroGDS creates temporary
construction lines that you can use to help position and align
graphics precisely

For more details about snap guides, see Chapter 5, Entering
positions.

� the pointer constantly changes to identify the type and location of
the nearest snap point (if you have the ‘Dynamic pointer position’
check box selected in your preferences)

MicroGDS provides snapcodes to enable you to snap exactly to any
given point in a window. This ensures accuracy in drawing,
selecting, moving, and placing graphics. For details about the
snapcodes, see Chapter 5, Entering positions.
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When you switch to print layout for the first time, MicroGDS displays
the Page Setup dialog box for you to set your paper size requirements.
For example:

The name of the paper displayed in the Paper box defines the
orientation, paper size, and margins of the current paper. MicroGDS
uses a paper sizes file to determine the paper definitions available to
you. A sample file called ‘paper sizes.csv’ is installed to your
MicroGDS Programs folder and is automatically referenced in your File
Location preferences. For details about editing or creating a paper sizes
file, see Chapter 17, Customizing MicroGDS.

You can select any paper available to you. You can also change any of
the displayed settings, for example, you can increase the margins to add
more white space around your graphics.

When you subsequently select print layout, MicroGDS uses the paper
definition that you set up. The paper definition is saved with the
window when you save the document. To change the assigned paper
size at a later date, use the Window, Page Setup command on the File
menu, or click the Page Setup button on the Window Editor. The
Window Editor is described in Chapter 4, Using layers and phases.
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When you work with a document, you will constantly need to change
the extent to see different parts of the view in the window definition. In
MicroGDS, you can move around a view, and you can zoom in and out
to enlarge or reduce the extent.

Each time you change a view, MicroGDS records the new parameters
and updates the view parameters.

There are a number of ways in which you can view different parts of a
window definition. For example, you can use:

� the zoom commands and the zoom bar

� the scroll bars

� the viewing buttons

� the Navigate window

� commands on the View menu

You can also view and manually change the parameters using the View
Parameters command on the Window menu. More details about the
view parameters are given in Chapter 9, Working in 3D.

If you are using a wheel mouse, you can zoom in and zoom out of the
current window by rotating the wheel, and pan the window by pressing
the wheel whilst moving the mouse.

The zoom bar, scroll bars, and the viewing buttons are known
collectively as the view controls. You can choose which view controls
you want to be made available on your windows. For details, see Setting
the view controls on page 53.



















57

Chapter

33
��
����� �����
�&���'������

�()�	��

�
�&���'��������()�	��
All the graphics you see in a drawing consist of primitives and objects.
A primitive is a basic graphic item, such as a line or a block of text. An
object is a collection of graphics, which can be primitives or objects.
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A primitive is a graphical element drawn using a single command.
Primitives are the building blocks of a drawing. There are several types
of primitive:

� line primitives

Line primitives include multi-segments lines, arcs, circles,
rectangles and so on. Details on line primitives are given in Line
primitives described next.

� text primitives

Text primitives can be created in MicroGDS or can be imported text.
Details on text primitives are given in Chapter 8, Working with text.
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� OLE photo primitives

OLE primitives (Object Linking and Embedding) include Adobe
Acrobat and Microsoft Office documents and graphic images saved
as bitmaps. Details on OLE primitives are given in Chapter 15,
Working with different file formats.

� window photo primitives

A window photo primitive is a snapshot of the graphics in one
window that is displayed in another window. Details on photo
primitives are given on page 59.

� raster primitives

Raster primitives are images inserted into a drawing. Details on
raster primitives are given in Chapter 15, Working with different file
formats.

� clump primitives

Clump primitives are made of a material, and can also have a
different material allocated to each face. Details on clump primitives
are given in Chapter 9, Working in 3D.

Primitives are grouped together into objects; one primitive can be part
of only one object.
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Line primitives are made up of vertices and segments:
� a vertex is a point where two line segments join (for example, a

corner), or the point at the start and the end of a line

� a segment is a line between two vertices; it can be straight or curved

A number of MicroGDS commands work on paths. A path is a distance
along a line primitive between any two selected points (these do not
need to be vertex points). For example, you can delete a path or change
the linestyle of a path.



99

Chapter

44
������#�-�
������������

6�-�
�
MicroGDS enables you to divide your drawings into logical and
manageable portions by using layers. All the graphical data (primitives
and objects) in a document are drawn on layers. You can regard layers
as transparent overlays, with different parts of the drawing produced on
each overlay.

For example, if you were producing an cinema complex, you might
structure the drawing on the following layers:

� layers 1 – 10: the architectural detail

� layers 11 – 25: seating arena and foyer

� layers 26 – 30: wiring detail

� layers 31 – 34: lighting and projection

� layers 35 – 36: sprinkler system

If you create a new document and immediately begin drawing,
MicroGDS creates a layer for you, with the name ‘default’. You can
rename this layer or create a new layer to use.

You can also change the default layer name that is used for each new
window definition if you do not explicitly create a layer, in your
preferences.















106 Using MicroGDS 11
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� in the phases list, on the shortcut menu, click Select All

When you select multiple phases, the values for one or more properties
may become blank or appear unavailable. This indicates that the phases
have different values for those properties. If you change one of these
values, all selected phases assume the new value.
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The order in which the phases are numbered determine which graphics
are drawn over the top of other graphics (phase 1 is drawn first). You
can change the position of a phase in the sequence, thereby changing
the order in which graphics are overlaid.
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� in the phases list, drag the phase up or down the list

� 3��&�'����������������������
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� select the phase to move and, on the shortcut menu, click Move to
Top or Move to Bottom

Note that if you have changed the sort order, for example, to sort by the
‘Linked layer’ name, this changes only the sort order in the phases list;
phases are always drawn in numeric order.

If you are using mask (or opaque) linestyles, take care when reordering
phases. Unless the phases are correctly ordered, you might not be able
to see graphics which are referenced in different phases. For details
about creating and using mask linestyles, see Chapter 7, Working with
linestyles.
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Each phase determines the editing status of the graphics on the layer
with which it is associated. The editing status can be one of the
following:

� Editable (E)

You can edit and hit existing graphics, and create new graphics.

� Hittable (H)

You can hit existing graphics, but you cannot edit them or create
new graphics.



Chapter 4: Using layers and phases 107

� Visible (V)

You can see existing graphics, but you cannot hit or edit them, or
create new graphics.

� Invisible (I)

You cannot see, edit, or hit existing graphics, or create new graphics.
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1 In the phases list, point to the phase whose status you want to
change.

2 On the shortcut menu under the Status column, click the editing
status you require.

Alternatively, click the Status button you require on the Phase tab.

Tip: to change the editing status of a phase to Editable and make its
layer current, double-click the phase in the list.
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MicroGDS automatically assigns a colour for the graphics in each
phase. The default colours for phases are set in the document properties.
The colour allocations are saved when you save a document, therefore,
you can have different colour allocations for each document. You can
also copy the colour allocations of a document to and from the
document defaults, which are used for all new documents. For details
about changing the default colour allocations, see Chapter 17,
Customizing MicroGDS.

If you have the Colour list on a status toolbar, the colour assigned to the
graphics in the current phase is shown in the box. Unless you change
the colour of individual graphics, the Colour box shows ByPhase. This
indicates that MicroGDS is using the phase colour for new graphics.

All graphics in the phase are drawn in the phase colour (unless you
change the colour of individual items using the Colour list). If you
change the colour of an individual graphic, the colour (and its number
or value) is shown in place of ByPhase.
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1 In the phases list, point to the phase whose colour you want to
change.

2 On the shortcut menu under the Colour column, select an existing
colour or choose a new colour in which you want the graphics to be
displayed.

To assign a colour that is not available from the list, click the ‘Select
colour’ entry. Then, select your colour using the Select Colour
dialog box. For details about using the Select Colour dialog box, see
Chapter 3, Working with primitives and objects.

Alternatively, select the Colour you require on the Phase tab.
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You can set colours for individual graphics. By default, graphics are
shown in their set colours. Graphics that have not been set explicit
colours are shown in their phase colours.
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1 In the phases list, select the phase that uses set colours for individual
graphics.

2 On the Phase tab, select the Use primitive colours check box.

The graphics are drawn in their set colours, and not in the phase
colour.
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You can set colours for individual linestyle strokes and charstyles. For
example, you might have a linestyle that has a red border, and a green
fill, or a charstyle that uses a blue font.
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1 In the phases list, select the phase that uses styles with the embedded
colours you want to retain.

2 On the Phase tab, select the Use style colours check box.

The styles are drawn in their embedded colours, and not in the phase
colour.
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When you delete layers in a single-user drawing, the graphics on that
layer are deleted from disk when you save the file. All phases that
reference the layer are also deleted.

Note that if you want to delete layers from multi-user projects, you must
use the MicroGDS Project Administrator utility. For more information,
refer to the online Help for the Project Administrator (if the Project
Administrator utility is available to you).
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1 In the Document Organizer, ensure that the document from which
you want to delete the layer is the current document.

2 Click the Layers tab and then select the layers that you want to
delete.

3 Press Delete, or on the shortcut menu, click Delete.

4 To confirm the deletion, click Yes at the prompt.
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Although objects are created on the current layer, you can move and
copy selected graphics from one layer to another—within the same
document or to another document.
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1 Press F10, or on the Edit menu, click Select Objects.

2 Select the objects to move.

3 On the Object menu, click Get.

4 Select the layer to move the objects to by clicking an object already
on that layer.
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1 In the source MAN file, press F10, or on the Edit menu, click Select
Objects.

To copy all objects on a layer, make all other layers not editable and
then press F7 or click Select All on the Edit menu.

2 To copy the objects to the Clipboard, press Ctrl+C, or on the Edit
menu, click Copy.



120 Using MicroGDS 11

3 In the destination MAN file, make the layer you want the objects to
be copied to, the current layer.

Ensure that a phase that is linked to the layer is editable.

4 To paste the objects onto the layer, press Ctrl+V, or on the Edit
menu, click Paste.
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Each layer in a multi-user project is stored in a separate layer file (a
.LYR file) and is referenced by the window definitions. When you open
a window definition, MicroGDS reads the list of layer names and looks
for the graphics that appear on those layers in the layer files. A window
definition can best be described as a set of filters on the graphical data
held in the .LYR files.

In the same way that each layer in a single-user document has a unique
link number, each layer file in a project also has a unique layer link
number. In a project, the layer link number is also used for the file name
of the layer. For example, if you create a new layer called
‘Foundations’, MicroGDS assigns it the next available layer link
number, for example, link number 78. Consequently, the file name on
disk is 78.LYR. It is important that you do not change the name of the
layer file (.LYR) in the Windows Explorer. If you do change the name
and you open a window definition that references the layer, an error
message is displayed.

The layer link numbers in a project can be used when multi-user project
files are shared over remote sites. The project manager can allocate
layer link number ranges to each site, using the Project Administrator.
The Project Administrator is available from the MicroGDS Program
menu. For details on how to use the Project Administrator, refer to the
utility’s online Help.

Each time a new layer is created, it is added to the project database.
Details about all the layers in the project database are recorded in the
Document Organizer. Other users can access the layers using the
Document Organizer and can copy or link a layer directly to a window
definition.

Because a layer can be referenced by more than one window definition,
more than one user can open a layer at one time. To prevent more than
one user editing the same layer at the same time, when a user opens a
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layer or creates a new one, they take ownership of that layer and
MicroGDS locks the file. This means that one user can edit the file and
other users can open it and snap onto the graphics, but cannot edit it at
that time. When the owner has finished editing a layer, they can disown
the layer which then enables another user to take ownership. This is
described further in the later section Changing ownership of a layer on
page 123.

Note that there is virtually no limit to the number of layers you can
create in a multi-user project.
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The name assistants enable you to create layers and objects whose
names conform to the naming standards in use at your site. Layers and
objects have separate configuration files. For information on using
object name assistants see Chapter 2, Exploring MicroGDS.

The layer name configuration file determines the names to be used for
new layers. For multi-user projects, this file can also define the location
in which a layer of a particular name should be located.

Any rule in the layer name assistant configuration file can have an alias
added to it. When an entry is selected from the top-level names in the
Layer Name dialog box, if there is a relevant alias attached and that
alias is defined in the project, that alias is selected in the alias location
of the dialog box.

To attach an alias to a rule in the file, add the alias in parentheses to the
end of the expansion text. For example:

ELEC–(Lighting)|Electrical

specifies that the alias name Lighting will be selected in the Layer
Name dialog box when a new layer starts with ELEC-.

You can also override a previously specified alias for a specific
expansion only. For example:

ELEC–|ALARM~(Security)|Alarm installation

overrides the alias set for the top-level entry for this specific expansion
only.
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When you create a new layer in a multi-user project, you can select the
layer alias in which to save the new layer.

Note that aliases are defined in the project database. For details about
creating a project database, see Chapter 16, Multi-user projects.
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1 Press F2, or on the File menu, or click Window, Edit.

2 In the Window Editor, click the Layer tab and then click New Phase
& Layer.

The Layer Name dialog box is displayed, for example:

If you are using a layer name assistant, a list of layer categories is
displayed in the top list box. If you are not using the name assistant,
this box is empty.
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3 Specify the name for the new layer.

By default, all new layers are saved in the location defined by the
default layer alias set for the workspace. However, if you are using a
layer name assistant the layer name configuration file may define
the preferred location to which a layer of a particular name should
be created. For more details, see the previous section, The layer
name assistant in multi-user projects.

4 Select the alias that defines the location in which you want to save
the layer from the list at the bottom of the dialog box.

Note that you can override the default alias for new layers for the
current work session using the Alias Overrides command. For
details about overriding the default aliases, see Chapter 16,
Multi-user projects.

5 Click OK.

Creating a new layer automatically creates a phase to refer to the newly
created layer.
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You can edit layers only if you ‘own’ them. When you create a new
layer, or when you are the first person to open a layer for editing (an
editing status of Editable), you are given ownership of the layer. Other
users can open the layer as Hittable or Visible, but cannot edit it.

When you save changes to a layer that you are editing, other users can
update to see the changes.
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1 The current owner must first save the window definition that
references the layer.

2 Once the window definition has been saved, in the Phases list in the
Window Editor, select a phase that references the layer whose
changes you want to see.
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3 On the Layer tab, click Update Layer(s):

The most up-to-date version of the layer is now available. Any edits that
have been saved by other users are displayed.
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1 The current owner must disown the layer by:

a) selecting a phase that references the layer, and then

b) clearing the Owned check box on the Layer tab

If changes have been made to the layer that have not yet been
saved, MicroGDS prompts whether to save the changes or
discard them.

2 Another user can then take ownership of the layer by:

a) selecting a phase that references the layer, and then

b) selecting the Owned check box

The ownership of other phases that reference the layer is also
changed.

You can also own and disown a layer using the shortcut menu in the
Mini Window Editor.

When you disown a layer, the editing status of any editable phases that
reference the layer is changed to hittable. Another user can then take
ownership of the layer for editing.

Note that when you close a project workspace, all layers are
automatically disowned.
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You cannot delete layers from a multi-user project using MicroGDS.
The project manager can delete duplicate and unused layers using the
Project Administrator.

The Project Administrator is available from the MicroGDS Program
menu. For details on how to use the Project Administrator, refer to the
utility’s online Help.
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Many commands in MicroGDS require you to enter a position. You can
specify the position by using a snapcode to snap to existing graphics or
snap in free space, or by typing coordinates.

If you make a mistake when specifying a position, you can often use
Backspace to cancel the position.

MicroGDS provides the following drawing aids which you will find
useful when locating a position.

� snap guides which are drawn automatically for you to snap to

� a grid which you can use to help lay out your drawing

� the x, y, z buttons which you can use to fix a coordinate

� a current position from which you can measure relative coordinates
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By default, the position of the mouse pointer is shown in the Position
box at the bottom of the MicroGDS window.

This shows that the current position is 664mm along the X axis, 859mm
along the Y axis, and 0mm along the Z axis. The D represents the Dot
snapcode. The coordinates and snapcode are dynamically updated as
you move the mouse.

You can change your preferences to show the last hit position instead.
For details about changing your preferences, see Chapter 17,
Customizing MicroGDS.

Note that unless you snap to a graphic that has a Z coordinate, or you
explicitly type a Z coordinate, the previous Z coordinate is used. If no
graphics in the window have a Z coordinate, you can omit the Z value
as it will always be 0.
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Snapcodes enable you to snap exactly to points on the graphics. This
ensures accuracy in drawing, selecting, moving, and placing primitives
and objects.

As you move the pointer around, you see snapcodes displayed at their
appropriate positions as the pointer passes over them. For example:

and

MicroGDS tries to anticipate what you are trying to snap to based on
the command you are using and the position of the mouse pointer. You
can accept the suggested snapcode by clicking the mouse button or
choose a different one by typing an explicit snapcode.

When MicroGDS looks for a snapcode to show, a default distance is
used which determines how far away from the mouse pointer to look.
Usually, this distance will be suitable. You can, however, specify your
own hit-radius value, using your preferences.
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All line primitives have a linestyle, which defines what the line looks
like. A linestyle is made up of one or more strokes. Each stroke defines
specific characteristics of the linestyle. For example, one stroke can
define the line thickness, another can define the fill properties, and a
third stroke could define an offset pattern.

For example:
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MicroGDS provides a variety of built-in linestyles for you to use or
modify. When you create a new document, two linestyles are always
available: DEFAULT and BLANK.
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For single-user documents, new linestyles are stored in the document.
They are saved when you save the document.

You can also access linestyles from external style files (called
LINES.STY). To do this, you specify the folders in which the
LINES.STY files are located using the Style Search Path command on
the File menu. You can add more than one folder to the style search
path, but only one LINES.STY file can be stored in each location. If
you modify and save a style from an external style file, it is saved in the
document. For more details about style files, see Chapter 2, Exploring
MicroGDS.

For multi-user projects, all linestyles are stored in external style files
(LINES.STY). New linestyles are saved in the first LINES.STY
location on the style search path. A linestyle is saved in the style file as
soon as you save the style, even if you do not save the project.

You can access linestyles available to a document from the Document
Organizer and also from the status toolbar.
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1 On the Document Organizer, click the Styles tab:
����������

2 Double-click the Linestyles category, or click the plus sign (+) to the
left.

A list of all locations from where you can access linestyles is shown:

� for a single-user document, the name of the document with
which you are working is shown first, followed by the path of
each style file defined in the style search path if any

� for a multi-user project, the name of the first style file defined in
the style search path for the project is shown first, followed by
the path of each subsequent location defined in the project

If a LINES.STY file exists in the location defined for styles and
fonts in your file location preferences, this location is shown last in
the list. This enables you to reference a set of global style files that
are available to all your documents. For more details, refer to Help.
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3 To display a list of linestyles in a location, double-click the location
or click the plus sign (+) to the left.

For example:

Linestyles are prefixed by an icon. The colour of the icon
determines the availability of the style:

� linestyles that can be used in the document are prefixed by a red
icon

� linestyles that are not currently available to the document are
prefixed by a grey icon

(A linestyle is unavailable if a linestyle of the same name already
exists in a location higher in the style search path.)

4 To preview a linestyle, select the style and then, on the shortcut
menu, click Toggle Preview.
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� on the Line box on the status toolbar, click the arrow

All styles available to the current document are listed.

4��������#�����-#�
You can add a new linestyle to a document by saving one from those
available with MicroGDS or by creating your own.

When you add a linestyle, it immediately becomes current and any
selected graphics are assigned that linestyle. Any new graphics you
draw are also assigned the current linestyle.









222 Using MicroGDS 11



� �������%


It is not necessary to be in 3D view to draw 3D objects. When you draw
a 3D object, you supply a Z coordinate in addition to the X and Y
coordinates. Whenever you do not explicitly specify a Z coordinate,
MicroGDS uses the last specified Z position. If no Z position has been
given, the Z coordinate is zero (0).

Although you can draw 3D objects in a two dimensional view, you
might find it difficult to visualise without seeing the object in 3D.

When you are working in a 3D view, you can use the Z axes snap guide
to help locate a 3D position. MicroGDS generates a Z axis snap guide
during many commands, through the current position and whenever you
hover over an End, Point, Inside, Centre, or Middle snapcode. You
switch the Z Axis option on and off using your Snapping preferences.

For more details about using snap guides, see Chapter 5, Entering
positions.
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When you switch to a 3D view, the graphics are drawn in the last 3D
projection. The first time you view the graphics in a window definition
in 3D, the eye position and look-at point are set up to show the extent of
existing graphics, centred in the window.

The eye position is your position in space, and the look-at point is the
point on the drawing at which you are looking. Together, these define
the direction of viewing (your line of sight) across a scene. For
example:
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The default buttons on a 2D window are described in Chapter 2,
Exploring MicroGDS. More details about choosing view controls are
given in Chapter 17, Customizing MicroGDS.

3���������	�&&����

MicroGDS also provides a set of nudge commands to enable you to
move the view up, down, left, and right.

The effect of a nudge command depends on the active nudge mode and
the current 3D projection. MicroGDS provides three nudge modes that
you use to nudge a 3D view:
� ‘Swing Round mode’ swings around the model

� ‘Walk Through mode’ walks through the model

� ‘Slide Past mode’ slides past the model
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1 On the View menu, click Alter View, Nudge, and then click the
nudge mode you require.

2 On the viewing buttons or on the View toolbar, click the nudge
direction button you require.

Alternatively, on the View menu, click Alter View, Nudge, and then
select the nudge direction.

For details on the nudge modes and each of the nudge commands, refer
to Help.

By default, the view is nudged by a 5° angle or by a distance of 10%.
You can change the amount in which the view swings or walks using
the Nudge Parameters dialog box, available from the View menu (Alter
View, Nudge, Parameters). For more details, refer to Help.

Note that you might want to assign shortcut keys to the nudge
commands and use them as an alternative to the mouse-based
navigation facilities. For details about assigning shortcut keys, see
Chapter 17, Customizing MicroGDS.
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A MicroGDS document has a view which consists of 2D, print layout,
and 3D parameters. A 2D view has an extent and a rotation from
horizontal. A print layout view has only an extent. A 3D view is either
parallel or perspective; these two views share the eye point and look-at
point parameters.
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When you switch between views, MicroGDS remembers the view
parameters independently. You can use the View Parameters dialog box
to display the projection and view parameters for the current view, and
set new parameters.
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� on the Window menu, click View Parameters

MicroGDS displays the view parameters for the current view, for
example:
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By default, the View Parameters dialog box is displayed in its shortened
form, showing the parameters that you are most likely to be interested
in. To expand the dialog box to see more parameters, click >>>. When
the dialog box is expanded, you can shrink the dialog box by
clicking <<<.

Use this dialog box to change the current projection and the line of
sight, as described next, and any other parameters specific to the
projection type. You can also create new saved views and recall and
apply any existing saved view from the View Parameters dialog box.
For full details on changing the view parameters and working with
saved views, refer to Help.
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There are two types of projection used in MicroGDS: parallel
projections, and perspective projections.

The first time you view a drawing in 3D, MicroGDS shows the graphics
using a 3-point perspective projection with a zoom angle of 60°. In a
3-point perspective projection, lines that are parallel to each other but
are not parallel to the projection plane (your screen) converge to a
vanishing point.

If the set of parallel lines is itself parallel to an axis, the vanishing point
is called a principal (or an axis) vanishing point. A 3-point perspective
projection has three vanishing points, corresponding to the X, Y, and Z
axes. The line of sight is defined by the eye position and look-at point.
You can also specify 1-point or 2-point perspective projections.

With a perspective projection, you specify the angle subtended by the
cone of vision at the eye position. The default angle of the cone is 60°,
but you can specify any angle between 0.1° and 179.9° (depending on
the number of decimal places for angles set in your preferences).

When you change the cone of vision, MicroGDS automatically includes
all graphics in the perspective view. Therefore, this angle also
determines the location of the eye position.

MicroGDS offers a range of standard parallel projections, such as
Isometric and Orthographic. For details about these projections, refer to
Help.

You can change the projection of a view using the View Parameters
dialog box. You can also view and change the eye position, look-at
point, and other parameters. Whenever you change the view, MicroGDS
stores the current view in memory so that you can return to a previous
or next view.
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1 On the Window menu, click View Parameters.

2 From the Projection list, click the projection you require.
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MicroGDS provides a number of facilities to help you keep track of the
status of your documents and their contents. These enable you to:

� view properties about the selected graphics

� query a graphic at a specific position

� measure primitives and objects, and count the objects on a layer

� track commands and prompts during the current session

� write a list of all objects in the current window, and their
occurrences

� record details about objects in the current window

In addition, you can assign non-graphical information (called attributes)
to primitives and objects. For details about attributes, see Chapter 14,
Working with attributes and schemas.

This chapter summarizes the ways you can assign and view
information. Full details are given in Help.
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A particularly useful facility for viewing information is the Properties
window. You use the Properties window to view extensive details about
the selected primitives or objects. You can also change the values of
many properties that are displayed.

For example, you can view the colour and linestyle of a line primitive,
the name of the object in which the primitive is stored, and the name of
the layer on which the object resides. You can also view attributes
assigned at each level.

In addition, you can switch to query mode to view details about any
specific position of a graphic. For example, you can query the face of a
material or the length of a line.

� 3������#�-������
���
����� ���� 

1 Press Ctrl+Q, or on the Window menu, click Properties.

2 Select the items whose properties you want to view.

The properties are shown for the currently selected items. For
example:

Note that link numbers are shown only if you have ‘Show Advanced
properties’ selected in your preferences.
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The buttons at the top of the Properties window enable you to view
and select the data in the window in different ways.

You can change the value for any property that is not read-only.
Read-only values are indicated by a grey background.

3 To update the window with details about a new selection, select the
items.

If you select multiple items, any property for which different values are
assigned show «Mixed». For example, mixed is shown if you select two
line primitives which are assigned different linestyles. Note that if you
change a mixed value, the new value is assigned to all selected graphics
to which the property applies.

If the selection includes graphics of different types, any property that is
not common to all the selection is shown in italic. For example, if you
select a line primitive and a text primitive, only colour is the common
property so all other properties are shown in italic. Furthermore, if any
property is the same for all graphics of the same type, that property is
shown in italic. For example, if the selection includes multiple text
primitives which are assigned the same charstyle, the charstyle is shown
in italic.

You can also use the Properties window to assign a document label for
information. This can be used, for example, as a reminder about the
status of a document. Note that you must be in Details display to see the
document label:
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Note that if you are working with a multi-user project, you can add a
project label and a workspace label.

You can copy the information from the Properties window to the
Clipboard. You might do this, for example, to paste some of the
information into another Windows program.
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You can query any primitive that has an editing status of hittable or
editable that you hit. Details about the item are shown in the Properties
window.

You can initiate query mode directly from the Properties window or
using the Query, Details command.
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1 Do one of the following:

� on the Properties window, click 

� on the Query menu, click Details

The mouse pointer changes to 

2 Click the graphic at the position you want to query.

The details are loaded into the last selected view of the Properties
window. You can change the view using the three view buttons at
the top of the window.

By default, the graphic is queried at primitive level. To query the
graphic at object level, press Shift when you click the graphic.

3 When you have finished querying graphics, click  or press Esc.

For full details about viewing and changing properties, refer to
MicroGDS Help.
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The Query menu provides commands for measuring graphics. For
example, you can measure:

� the angle between two lines

� the area enclosed by a primitive or object

� the distance between two points

If the Query dialogues check box is selected in your preferences, a
Query Measurements dialog box is displayed when you measure
graphics. For example, when you measure a path of a graphic, the
following dialog box is displayed:
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You can use the Copy button on the dialog box to copy the displayed
measurement. You can then paste the information as plain text (for
example, using Edit Paste) or, for some measure commands, as linked
data (for example, using Edit Paste Special) in MicroGDS or in another
Windows program.

The measurement is also displayed in the Dialogue window (described
next), if you have it open.

The measurement is displayed in the set units, regardless of the units
used to draw the item. When you measure graphics, if the scale is
important, such as when you measure the area of a graphic, MicroGDS
displays the area in the object scale and the current set scale.

For details about using the query commands, refer to Help.
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To track the commands you have chosen in the current session, with
their prompts, use the Dialogue window.

You may find it useful to have the Dialogue window displayed while
you are learning how to use MicroGDS, until you are familiar with the
commands.
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� press Ctrl+D, or on the Window menu, click Dialogue

The Dialogue window is displayed showing information about the
session. For example:
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MicroGDS can scan a window definition and produce a list of all the
objects and the number of times they occur in each phase in the
window. The list is written to a text file called list.txt, in the Text files
folder specified in your preferences. If you have not specified a Text
files folder, the text file is created in the folder in which MicroGDS is
installed.
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1 Ensure that the status of each phase you want scanned is either
editable, hittable, or visible.

MicroGDS does not scan phases that are invisible.

2 On the Object menu, click List.

MicroGDS generates the text file and displays it in a Notepad
window:
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The first line in the text file shows the window definition name in
the MicroGDS document. The remainder shows details about:
� the phase number, together with its editing status, colour,

modification status, and the name of the layer to which the phase
is linked

� the name of each object included in the phase, and the number of
objects with that name

�
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The Object Schedule facility creates a report on objects in the current
window.

Before you create a report, you must create a format file (with an
extension of .FRM) to determine the data and layout of the information.
How to create a format file is described below.

MicroGDS writes the report to a text file in the Text files folder
specified in your preferences. If you have not specified a Text files
folder, the text file is created in the folder in which MicroGDS is
installed. The name of the file is the same as the format file with a .txt
extension. Each time you create a report, the previous report file is
overwritten. Therefore, if you want to keep a report, rename the file
before you create a new report.
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1 On the Object menu, click Format.

The Open dialog box is displayed for you to locate the format
definition file to load.

If you have not yet created an appropriate file, see the following
subsection for details.

2 Select the format definition file you want to use, and click OK.

3 On the Object menu, click Schedule.

If you have any objects selected in the window, a dialog box is
displayed in which you can choose whether to schedule only the
selected objects or to schedule all objects in the window. Select the
option you require.

MicroGDS generates the report and displays it in a Notepad
window:
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The format definition file determines what the report produced by the
Object Schedule facility looks like. The report is in the form of a table,
with each row displaying details of a different object.

You create a format definition file with a text editor, such as Windows
Notepad. To enable MicroGDS to locate the file, save it with a .frm
extension.
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The following is an example of a format definition file.

Most rows start with the word ‘column’ followed by a range of column
numbers allocated to the information. For example:

column 1 12 NAME

means allocate columns 1 to 12 (in the report) for the information
specified by the following keyword. In this case, NAME, which prints
the object name.

For a list of available keywords, refer to Help.
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You can add new mnemonics to make them available in your document.
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1 Click the Styles tab on the Document Organizer, and then
double-click the Mnemonics category.

2 Do one of the following:

� to create a new mnemonic, select the Mnemonics category and
then, on the shortcut menu, click New

� to create a new mnemonic based on an existing style, select the
mnemonic on which to base the new style from the required
location and then, on the shortcut menu, click New based upon

MicroGDS displays the Mnemonic Definition dialog box.

For example:

3 Under Mnemonic, select the appropriate Applicability level:

� Window: enables you to assign the mnemonic to window
definitions

� Layer: enables you to assign the mnemonic to layers

� Object: enables you to assign the mnemonic to all objects of the
same name

� Reference: enables you to assign the mnemonic to a specified
object only

� Primitive: enables you to assign the mnemonic to primitives
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� click  to display an Edit Property Value dialog box in which
to enter the attribute value

For more details on assigning attribute values, see page 321.

Note that any default attribute values become active on the
Properties window only when you select the schema from the
Objectstyle list on the Properties window. If you do not select a
schema, all values default to «None».

8 To save the schema definition, click Save As and type the schema
name.

The name must comply with the MicroGDS naming rules as
described next.

You can modify and delete schemas using the Document Organizer. You
can also create and modify schemas using the Schema Definition
command on the Styles menu. For full details, refer to Help.
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Rules for naming mnemonics and schemas are:

� a mnemonic or schema name can contain up to 255 characters

� names can include spaces, except at the beginning or end of the
name

� names are case sensitive, so ‘Materials Used’ and ‘materials used’
are two different definitions

Note that the mnemonics and schemas supplied by MicroGDS for the
implementation and drawing of BIM intelligent objects follow special
naming conventions. For details about BIM intelligent objects, see
Chapter 3, Working with primitives and objects.

In addition, if you want to produce an object report that includes
attributes, do not name a mnemonic using any keyword used by the
format definition file. If a mnemonic name matches any of the format
file definition keywords, MicroGDS prints the details defined by the
keyword, and not the attribute value associated with the mnemonic.

For details about object reports and format definition files, see
Chapter 13, Getting information. Refer also to Help.



















327

Chapter

1515
��
����� ������00�
���

0�#��0�
&���

���
���	����
In MicroGDS, you usually work with MicroGDS documents. However,
using the import, export, publish, raster, and link commands, you can
also work with other file formats.

These facilities enable you to work with files created in, converted to,
or linked to, other software packages, such as AutoCAD, Adobe, and
Corel Paint Shop Pro.
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You can use the File Open command to open the following
non-MicroGDS file types:

� DXF (AutoCAD’s drawing exchange file format)

� DWG (AutoCAD file; a smaller version of a DXF file)

� AIF (GDS ASCII Interchange Format)

� BIF (GDS Binary Interchange Format)

� SKP (SketchUp)

� 3DS 3D Studio files

When you open a non-MicroGDS file, this is, in reality, a shortcut to
creating a new, blank file and then importing the third-party file.
MicroGDS performs the following actions, in the background:

1 First, MicroGDS creates a new, blank document.

If a blank MAN file template is specified in your preferences, the
new document is based on the template. This enables styles to be
transferred to the graphics.

2 The file is then imported into one or more window definitions.

If you are using a style mapping table, the graphics are translated
according to the style mapping table.

For more details, see Using mapping tables on page 332. Refer also
to Help.

The Window label in the Window Editor shows the path of the
imported file.

For some file types, the Layer labels are set to ‘Imported from
filename.xxx’.

Note that details of third-party files cannot be displayed in the
Document Organizer.

You can also transfer project files between GDS and MicroGDS
projects using the GDS Transfer utility. GDS is a product of Graphic
Data Systems, Corp. You can access Classic GDS Transfer from your
MicroGDS, Applications menu on the Start menu. For details on how to
use the utility, refer to the Classic GDS Transfer Help.
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Before you publish a view to another format, please check the Help to
see if there are any file-specific considerations that you need to be
aware of.

Note that if you publish graphics which have a sectioned view, the
invisible graphics are omitted from the resulting file.
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1 On the File menu, click Publish.

The Publish dialog box is displayed.

2 From the Save as type list, select the file format in which to publish
the graphics.

3 In the File name box, type the name for the file and click Save.

MicroGDS will automatically add the appropriate extension to the
file name.

Depending on the file format to which you are publishing,
MicroGDS opens a further dialog box which enables you to choose
output options for the resulting file. Many options in the upper part
of the dialog box are identical for each file type. Additional options
that you can use to set resolution and structure settings differ
depending on the file type. For details on each output option, refer to
Help.

If you are exporting to PDF format, MicroGDS displays the PDF
Export dialog box for you to specify the output for the resulting file.
Note that Adobe PDF format 1.6 is the recommended format.
(Adobe Reader 7 or later is required to read PDF 1.6 format
correctly.)
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Mapping tables can be used when MicroGDS translates files to and
from DXF, DWG, AIF, and BIF. They can be used to define how a file
should be opened or saved in MicroGDS.

There are two types of mapping tables available: style mapping tables
and entity mapping tables.

� a style mapping table defines which linestyles and charstyles are
used when MicroGDS translates files to and from BIF, AIF, DXF,
and DWG
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links within the same document. You might use paste-link within the
same document, for example, to place dynamic measurements in your
documents using the Copy button on the Query Measurements dialog
box. Linked Data format is available only when the source and
destination document are the same.

Note that MicroGDS Linked Data should be used in preference to DDE
data, which carries more overhead. Use DDE Link Data when you
paste-link data between different documents or between applications.

You can double-click a linked object to open it in the source program if
the source program is OLE 2 (Object Linking and Embedding)
compliant. For further details, see the section OLE on page 339.
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1 Open the document that contains the graphics whose measurements
you want to link to Excel.

2 Open the window definition that contains the graphics.

In a single-user drawing, you must ensure that the window
definition containing the graphics is designated as the principal
window in the document.

3 On the File menu, click Preferences.

4 On the General tab, ensure that the Query dialogues check box is
selected and click OK.

5 On the Query menu, click Area.

6 Click on a closed line primitive to measure the area of the primitive.

7 When the Query Measurements dialog box opens showing the area
value, click Copy.

Note that the DDE link contains information about the source file
name and location. Therefore, if the source file has not yet been
saved, the Copy command copies only plain text.

8 Start Excel and open a spreadsheet.

9 Select the cell in which you want to paste the area value.

10 On the Edit menu, click Paste Special.
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11 Select the Paste link option and click OK.

The area of the primitive at the object scale is pasted into the cell,
using the current set units and decimal places. During this session, if
the item in MicroGDS is altered so that its area changes, the area
value will be updated automatically in Excel.

12 If required, save the Excel spreadsheet.

When you leave Excel, the most recent data is stored along with the link
information. The next time you start Excel, a prompt asks if you want to
re-establish the remote link. If you click Yes, it will check for any
updates to the data, and continue receiving updates during the session.

(�)

You can embed an object from a MicroGDS document in a file in
another application.

OLE (Object Linking and Embedding) enables you to embed data from
one Windows program in another in such a way that, if you want to edit
that data, you can start the source program by double-clicking on the
embedded object. The source program is then started and loads the
relevant data.

For example, you might embed a window definition in a MicroGDS
single-user document in a Word document.
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Note that the following steps refer to Microsoft Office 2007. If you
have a different version of Microsoft Office installed, please see the
Microsoft Help for details.

If you are in Word:

1 Click in the document where you want to place the embedded
object.

2 On the Insert tab, in the Text group, click Object.

3 In the Object type box, double-click MicroGDS Document.

A MicroGDS document is inserted into the Word document.

4 To begin drawing in MicroGDS, select a command from the
Construct menu.

5 When you have finished, on the View menu, click Save View1.
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Use multi-user projects to enable several people to access the same
drawing data simultaneously.

The main difference between a single-user document and a multi-user
project lies in the way the drawing data is stored.

The graphical data for a multi-user project is stored in a series of layers,
and each layer is stored in a separate layer file (a .LYR file). This makes
it possible for different people to work on the same drawing by each
editing a different layer. When one person opens and begins to edit a
layer, the layer file is locked to prevent another user from editing the
file at the same time. More details about layers in multi-user projects
are given in Chapter 4, Using layers and phases.

The drawing data in a project is stored in window definitions, just as it
is for a single-user document. However, each window definition in a
project is stored in a separate window definition file (a .WND file).
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There is virtually no limit to the number of layers you can create. You
can organize the layers and window definitions into as many different
folders as necessary. For example, you could group all layers that
contain data for architects in one folder and all layers that contain data
for electricians in another.
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A multi-user project comprises a project database and one or more
project workspaces. The project database locates various project files,
including the layer files which make up the drawing. The project
workspace controls which layer files can be accessed by whom.

MicroGDS supplies a sample project called Sixhills to give you an idea
of how projects can be set up. This project is installed into your
MicroGDS Sample Drawings folder. You can use Windows Explorer to
see how the folders and drawing data are structured. If you open the
project in MicroGDS, you can use the Document Organizer to see how
MicroGDS presents the project to you.
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MicroGDS project databases can be created as MicroGDS .CPD
databases, SQL Server/MSDE (and SQL Server 2005 Express)
databases, or any other database that has an OLE DB provider which
complies to the ANSI SQL92 standard.

We do advise against using other types of database as there may be
problems with creating the database table. If you do wish to create a
project using other types of database, please contact MicroGDS support
for more information.

By default, databases will be created in Jet 4.0 (Access 2000) format.
These types of project database have the extension .CPD.

Note that you cannot create or use CPD databases if you have installed
the 64-bit version of MicroGDS on a 64-bit machine. If you do have
existing CPD databases that you want to continue to use, you might
want to consider installing the 32-bit version of MicroGDS instead.

The project database defines the locations of the files that are to be used
in the project. This includes the window definition files, layer files,
raster files, and instance object libraries. It also defines the locations of
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the style files. Style files contain the definitions of the charstyles,
linestyles, materials, lightstyles, and mnemonic definitions used in a
MicroGDS project.

The locations of the project files are defined when the project database
is created. Additional locations can be specified at a later time, and
existing locations can be changed or removed by the project manager
using the Project Administrator. The Project Administrator is available
from the MicroGDS Program menu on the Windows Start menu. For
details on how to use the Project Administrator, refer to the utility’s
online Help.

When you define the file locations, you use aliases. An alias is a way of
mapping an arbitrary name to a physical file location. This enables you
to use a name of your choice in place of specifying the full pathname,
similar to using Windows shortcuts. For example, you could map the
alias name ‘Architectural Drawings’ to the folder
c:\MicroGDS\Projects\SitePlan\Architectural. If the architectural files
are later moved to a different folder, only the pathname of the alias in
the database needs to be changed. You do not need to update it each
time one of the files is referenced.

You can use a project template when you create a project database.
Project templates provide a folder structure for holding all files related
to the project, as well as a set of styles. Templates are described on
page 344.
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The project workspace contains information relating to a project, such
as the project database to be used, the layers that are editable, and the
default locations in which to save new files. Many workspaces can be
defined for the same project, enabling different users to access different
data. A project workspace has the extension .CPJ.

For example, if you have a project to design a building, the project
database would contain all the layers relating to the building. You could
then set up different workspaces for different disciplines. All users
would be able to see the overall building plan, but designers working on
electrical data would work in the electrical workspace and have access
to wiring plans, and designers working on plumbing data would work in
the plumbing workspace and have access to piping layouts, and so on.
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When you open a project workspace in MicroGDS, data relating to the
workspace is displayed in the Document Organizer. Each tab on the
Document Organizer gives access to specific project items. For
example, the style categories are listed on the Styles tab, and the
window aliases available to the project are listed on the Window
Definitions tab.

For details about opening project workspaces and working with the
project data, see Working with project workspaces on page 356.
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MicroGDS supplies two sample project templates that you can use
(Basic.cpd and Working.cpd), or you can create your own.

The Basic and Working templates both use a MicroGDS .cpd database
file, but they could use any other type of database such as a SQL Server
database.

Before you can use a project template, you must add it to the template
list in your preferences. For details, refer to Help.
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Both the Basic and the Working templates have the following structure:
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The Basic template provides only the structure for the project database.

The Working template includes some additional files:

� a project workspace file (Entire Project.CPJ)

� Layer

A layer files alias location to store the layer files (.LYR) which store
the drawing data.
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� Library

A library files alias location that you can use to store and access
object libraries. (An object library is a .MAN file that contains
objects that can be inserted into window definitions.)

� Raster

An image files alias location containing sample TIF files that can be
used to insert raster images into a drawing.

� Styles

Contains a CHARS.STY file and a LINES.STY file.

� Window

A window alias location, containing a subfolder called Frames
which provides some standard drawing frames.

When a new project database is based on a template, MicroGDS copies
this structure to the specified location. Note that any files that were not
created as part of the template are not copied.

By default, the project files are saved in the corresponding project
folders. For example, the layer files (.LYR) are stored in the Layer
folder, and the window definitions (.WND) are stored in the Window
folder. When a new style is created, if a style file of that type does not
already exist, MicroGDS automatically creates the appropriate style file
in which to store the styles. For example, LIGHTS.STY is created when
you create a new lightstyle and MATLS.STY is created when you create
a new material.

Note that project managers can manage multi-user projects using the
Project Administrator utility. The Project Administrator is available
from the MicroGDS Program menu. For details on how to use the
Project Administrator, refer to the utility’s online Help.
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The steps below summarize the basic procedure for creating new
project templates. For full details, refer to Help.
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1 Create a project database, with the alias names and style search path
that you want to use for the template.

2 Create the project workspaces, window definitions, and layers that
you want in the template.
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3 Copy any additional files that you want users of a workspace to
access, into the appropriate project subfolders. For example, you
might copy a number of raster images into a Raster location.

4 Add the project template to the template list on your Multi-user
preferences.

For details about adding project templates to the template list, refer
to Help.

When a new project database is created based on a template, MicroGDS
creates a project database with the name and in the location you specify,
based on the template. Any files and folders on the same level and
below the project database file (CPD) in the template will be copied to
the new project database. The new project database also stores the alias
names with their mapped locations, and the locations defined in the
style search path. The template can reference folders outside of this
structure, but the files within those folders are not copied to the new
project database.
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In this section, we describe how to create a MicroGDS Jet 4.0 (Access
2000) project database. This is the default format. The basic concepts
and procedures are similar for all types of project database creation. For
details about creating a project database of a different format, refer to
the Project Administrator online Help.

Before you create a new multi-user project, you should plan the
structure of the project. This will help to ensure that users of the
workspaces have access to the locations and files they require.

The structure of a project can be changed at a later date, for example, it
may be necessary to add a new folder to the style search path in the
project database. However, it is better to have the project well defined
before users begin to work with the project files. Changes to the
database (and workspaces) can be carried out by the project manager
using the Project Administrator. The Project Administrator is available
from the MicroGDS program menu on the Windows Start menu. For
details on how to use the Project Administrator, refer to the utility’s
online help.
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To create a new project, you:

� create the project database, if it does not already exist

� create the project workspaces
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1 On the File menu, click New.

The Create a New File dialog box is displayed:

2 Select ‘Project database’ and click Next.

The Create a New Project Database dialog box is displayed:
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3 From the Template list, select an existing project template on which
to base your new project.

If you do not want to use a project template, leave the selection set
to (No Template).

4 From the Database Type list, select Access 2000 (Jet 4.0).

5 In the Description box, type a short description for the project
database, if required.

The description can be read and amended using the Properties
window.

6 Click Next.

7 To specify the name of the project database:

� in the Name box, type the full path

If you type a location that does not exist, MicroGDS asks if you
wish to create it.

� or, click Browse to display a browse dialog box in which you
select the location for the project database. In the File name box,
type the name and click Open

You can set a default location in which to create a new project
database on the Multi-user tab of your user preferences.

If you do not include the .CPD extension, MicroGDS adds it
automatically.

8 Click Next.

If you based the project database on a template, the project database
is created and the Create a New Project Database dialog box is
closed. If you now want to create a project workspace:

a) On the File menu, click New.

b) In the Create a New File dialog box, select Project workspace.

c) Go to the next section Creating the project workspace.

If you did not base the project database on a template, MicroGDS
displays the Define Database Aliases dialog box.
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For example:

Aliases are the names you associate with the folders available to the
project. There are six alias types:

� layer aliases specify the folders for new layers

� window aliases specify the folders for new window definitions

� raster aliases specify the folders for accessing raster images

� library aliases specify the folders for accessing library files

� reference aliases specify the folders for accessing MicroGDS
documents that contain windows that can be used as photos
(these are optional)

� renderer aliases specify the folders for renderer files (these are
optional)

Reference and renderer aliases are optional; all other types of data
require at least one alias.

The default alias names for each file type are shown on the left side
of the dialog box; the default folder locations, which are relative to
the project database folder, are shown on the right of the dialog box.

If you accept these details, MicroGDS creates subfolders in the
project database structure with the names shown, and maps those
locations to the default alias names.

Note that the alias names are the names that you will see in the
Document Organizer.

9 You can use the Define Database Aliases dialog box to add, edit, and
remove aliases, as applicable.
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Note that if you map an alias to a network drive, the assignments
will work only for users who use the same standardized mapping of
drive letters to disks. If you do not use a standardized network
mapping system, you should specify the full network pathname
when you set up aliases.

To change the default alias name and/or location for an alias:

a) In the Define Database Aliases dialog box, select the default
alias and click Edit.

MicroGDS displays the details of the selected alias in the Alias
Editor.

b) Amend the alias name and the location to which the name refers,
as required, then click OK.

To add an alias:

a) On the Define Database Aliases dialog box, click Add.

MicroGDS displays the Alias Editor.

b) In the Name box, type the alias name.

c) Specify the location to which the alias name refers.

If the location is relative to the project database, type only the
folder name; you do not need to type in the full pathname. If you
type a location that does not exist, MicroGDS creates the
location for you.

d) From the Type list, select the type of file to which the alias
refers.

e) To allow the users of the workspace to expand an alias name to
show any subfolders in the project workspace window, select the
Expandable check box:
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f) Click OK.

The following example shows a Define Database Aliases dialog box
with the complete alias details for the project:

An absolute path is shown if you:
� type an absolute path

� browse to a location that is not relative to the project database
folder

Note that an X indicates that the alias is expandable.

10 Click Next.

If any alias folders do not currently exist, MicroGDS first asks if
you wish to create them.

MicroGDS then displays the Define Database Style Search Path
dialog box. MicroGDS uses the style search path to read and store
the style files. The default location for the style files is in the project
database folder.
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11 You can change the default folder, and add and remove folders from
the style search path as applicable.

To change a location in the style search path:

a) Double-click the entry.

b) Click the ellipses button to the right of the current entry.

The Browse for Folder dialog box is displayed.

c) Specify the new location for the style search path and click OK.

To add a location to the style search path:

a) On the Define Database Style Search Path dialog box, click Add.

b) Specify the location of the style search path and click OK.

The first location that you specify defines the folder in which styles
are updated and saved as you work. The style files in this location
are the local style files, and these contain the local styles for the
project. For example, if you create a new linestyle it will be saved in
the LINES.STY file in the location defined first. If the LINES.STY
file does not exist, MicroGDS creates the style file in this folder and
then saves the style to the file.

If you modify a style that is stored in a file in a subsequent location,
the modified version of the style is saved in the appropriate local
style file, and not in the file from which it originated.

Therefore, you would probably specify the style files that are
specific to the project first, and the additional style files second.

You can reorder the locations in the style search path using the
Move Up and Move Down buttons.
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12 Click Next.

13 To create a new workspace, select the Create a workspace check
box, then click Finish.

If you do not click the Create a workspace check box, you can create
a workspace at a later time by selecting Project workspace on the
Create a New File dialog box.
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When you create a project workspace, MicroGDS displays the Create a
New Project Workspace dialog box.

If you have just created a project database that was not based on a
template, and you selected the Create a workspace check box, the name
of the project workspace and the database are entered automatically in
the boxes.

For example:
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1 To specify the name of the project workspace:

� in the Name box, type the name for the project workspace,
including the full path if necessary

If you type a location that does not exist, MicroGDS asks if you
wish to create it.
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� or, click Browse to display a browse dialog box in which you
select the location for the project workspace, then type the name
in the File name box and click Open

Note that a default location for the project workspace can be set
on the Multi-user tab of your user preferences.

If you do not include the .CPJ extension, MicroGDS adds it
automatically.

2 In the Project Database box, specify the project database to which
the project workspace refers. You can browse for the project
database by clicking Browse.

The Connection String box is used when you create non-MicroGDS
.CPD databases.

3 In the Description box, type a short description for the project
workspace, if required.

The description can be read and amended using the Properties
window.

4 Click Next.

MicroGDS displays the Select Workspace Aliases dialog box. If you
did not create additional aliases for layers, only the default alias
name is shown.

5 Select the layer aliases for the layers that are to be editable by users
of the workspace:

� to enable all layers to be edited, select the All aliases refer to
editable data check box

� to disable users from editing specific layers, clear the All aliases
refer to editable data check box, and then select the aliases that
refer to the layer locations to be made editable
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For example:

6 Click Next.

MicroGDS displays the Select Default Aliases dialog box. For
example:

If additional aliases exist in the project database, you can choose an
alias of each type to set the default locations for the workspace.

For example, if users of this workspace are to work with structural
data, and aliases have been defined to store structural files, you can
set the structural aliases as the default aliases for those types.

Note that users of the workspace can override the default aliases for
new layers and windows, for the current work session. For details,
see Overriding default aliases on page 359.
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7 From the lists, select the default alias for each file type and click
Next.

8 In the final dialog box, select the appropriate check boxes to choose
whether to add the workspace to the Windows Start menu, and
whether to open the workspace immediately.

9 Click Finish.
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� on the MicroGDS File menu, click Open and select the file to open

� or, double-click a .CPJ file in Windows Explorer

� or, drag the file from Windows Explorer into the MicroGDS
window

The project workspace opens in the Document Organizer and becomes
the current document. If you do not have the Document Organizer
displayed, you can open it from the Window menu.

The window aliases available to the project are displayed on the
Window Definitions tab in the Document Organizer.

Each project workspace has a default window alias. The default window
alias name is shown in bold. If any window definitions have been saved
in the default window alias, the folder to which the alias refers is
expanded. For example:
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1 Ensure that the project is the current document in the Document
Organizer.

2 Press Ctrl+S, or on the File menu, click Save Project.

MicroGDS saves all new and modified window definitions and
layers. If you have any new window definitions that you have not
yet saved, MicroGDS first displays the Save Window As dialog box,
for each unsaved window.

For details about saving individual window definitions, see the next
section.
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1 Ensure that the project is the current document in the Document
Organizer.

2 On the File menu, click Close Project.

If there are any unsaved window definitions or layers in the project,
MicroGDS displays the Save Drawing dialog box for you to choose
the files that you want to save before the project closes. Click:

� Save All to save all changes and close the project

� Save None to close the project without saving any changes

� Save Marked to save selected changes and close the project

To select a change to save, click its name in the list.

� Cancel to cancel the close
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In a multi-user project, each window definition is stored in a separate
window definition file (a .WND file). The only difference between
working with a window definition in a multi-user project and working
with a window definition in a single-user document is that you must
save each window definition in a project to disk.

You can save a window definition and any layers that it references; you
can also save an existing window definition to a new name.
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1 Ensure that the window definition is the active window.

2 On the File menu, click Save Window & Layers.

The window definition and any layers that it references are saved.

However, if you are saving a new window definition, the Save
Windown As dialog box is displayed for you to specify the
window’s name.

MicroGDS opens the file location to which the default window alias
refers, and lists any existing window definitions in the dialog box.

3 In the Save Windown As dialog box, specify the location in which
you want to save the window definition.

To save the window definition to a different folder that has an alias
defined, select the alias from the Aliases list.

4 Specify the name for the new window definition file.

If you do not include the .WND extension, MicroGDS adds it
automatically.

5 Click Save.

It is recommended that you save the window inside the project
folder structure. If you save a window definition outside the project
folder structure, MicroGDS advises you that this is not
recommended and prompts you to confirm.

The next time you save the window definition, it is updated.
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1 Ensure that the window definition is the active window.

2 On the File menu, click Save Window As.

MicroGDS displays the Save Window As dialog box.

3 Specify the location and file name for the layer, as described in the
previous procedure.

4 The Save Window As dialog box includes options for you to choose
to reference the same layers as those referenced by the original
window, or to create copies of those layers instead. Click the
appropriate option.

5 Click Save.

For more details, refer to Help.
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Note that if you do not have permission to modify the local style files,
the Save and Save As buttons on the Modify dialog boxes are
unavailable.

You can create and modify styles using the File menu and the File
toolbar buttons. You can also create and modify styles directly from the
Document Organizer.

Lightstyles and materials are far more sophisticated in MicroGDS
Collaboration than those available in MicroGDS Entry Level. For
details about the additional lightstyle and material attributes available in
MicroGDS Collaboration, refer to Chapter 20, Advanced lightstyles and
Chapter 21, Advanced materials.
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You can transfer 2D GDS drawings to MicroGDS projects, and
MicroGDS projects to GDS drawings, using the Classic GDS Transfer
utility. GDS is a product of Graphic Data Systems, Corp.

Note that before you can use the transfer utility, you must ensure that a
project is the current document in MicroGDS.

You can access the Classic GDS Transfer utility from the Applications
menu on your MicroGDS Program menu.

For details on how to transfer files between GDS and MicroGDS, refer
to the Transfer utility’s online Help.
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This chapter describes the ways in which you can customize
MicroGDS. It covers how to:

� start MicroGDS from the command line

� change your preferences and settings

� change the defaults of a document

� create and load profiles

� create and customize toolbars, commands, shortcuts, and menus

� customize the BIM environment and define new BIM components

System administrators can also set up specific configuration files to be
used by everyone at their site.
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You can start MicroGDS from a command line (or shortcut icon) by
specifying the path and program file.
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� type the path that contains the MicroGDS program

Precede each folder name by a backslash.

If any part of a path contains spaces, enclose the path in quotation
marks (”).

For example:

”D:\Program Files\Informatix\MicroGDS\microgds.exe”

If you have a licence for more than one MicroGDS product, you can use
the /option parameter to specify which MicroGDS product to run.

You can also include a path to open a specific document in MicroGDS,
and start another application to run when MicroGDS has started.

For machines running Microsoft Windows Vista and later, you can add
a language name argument to set the user interface language to a
specific language.

The following examples assume that the location of MicroGDS is
”D:\Program Files\Informatix\MicroGDS\Microgds.exe”. Each
example builds upon the previous one, to show the full command line
argument.

The order of the parameters on the command line is:

MicroGDS_path MicroGDS_option MicroGDS_document
other_application

Examples

� To specify MicroGDS Collaboration as the program to run, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option Collaboration

� To start MicroGDS Collaboration and also open the document
C:\Drawings\Building plans\Stair construction.man, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option Collaboration

”C:\Drawings\Building plans\Stair construction.man”
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� To start MicroGDS Entry Level, open the Stair construction.man
document as above, and then start Notepad, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option ”Entry Level”

”C:\Drawings\Building plans\Stair construction.man” /app Notepad

� To start MicroGDS Entry Level and set the user interface language
to German, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option ”Entry Level”

/language DE

If preferred, you can create a shortcut on the desktop as a fast way to
start MicroGDS. For details, refer to your Windows documentation.
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Many of the customization options for changing the way an individual
system behaves are on the Preferences dialog box. These include:

� setting the selection and background colours

� specifying the default file locations for MicroGDS support files

� setting up name assistants for objects and layers

� defining the raster editors to use when you open a raster image

� setting up snapcode and snap guide options

� specifying the linestyles and charstyles for each type of dimensions

� specifying which MicroGDS commands are to be enabled or
disabled
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1 On the File menu, click Preferences.

The Preferences dialog box is displayed.

For example:

Note that if you are using MicroGDS Entry Level, you will not have
the Renderer tab on the Preferences dialog box.

2 Make the changes you require, using any of the tabs.

For a description of each option on each tab, refer to Help.

3 Click OK to save your changes.

���������-��
���������
Many user settings throughout MicroGDS are managed through user
preferences, just described. However, preferences and other settings can
also be controlled at other levels through the Preference Files Editor.
This gives control at user level, document level, CAD manager level,
and program level.
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Many companies will have office standards for different types of
MicroGDS items, such as layer names, colours, linestyles, and so on,
and have set up their working environment to suit. Sometimes a project
will require its own standards, such as where a client always uses a
specific set of phase colours to maintain its corporate image. As CAD
manager, the Preference Files Editor lets you set general and project
settings, allowing you to choose to override a setting on an individual
basis.

Restrictions may be set at any level to enforce its usage. This is called a
policy. For example, it might be your company policy to always display
the unit of measurement in dimensions. Where a policy is in place, any
subsequent change made to the setting’s value at any other level is
ignored. Note that settings that will be ignored due to a higher level
policy setting are shown with a pink background.

The settings and values are saved to a settings.xml files in the
appropriate location. This means that settings files can easily be copied
between machines. If you want to use a project-specific settings file
with a different project, just copy the settings file to the location of that
project.
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1 On the File menu, click Preference Files.

The Preference Files Editor is displayed.
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For example:

Use the Categories pane on the left to choose which settings to list
in the Settings pane. To list all settings, click Settings in the
Categories pane.

The Settings pane contains a number of columns. The first column
shows the name of the setting. The remaining columns correspond
to those places where the preference may be defined. To see the full
path of the settings file associated with a column, point to the
column title with the mouse pointer.

Each cell in each row shows the value of the setting, in each
possible location. The value in a cell is shown as follows:

� bold value indicates an unsaved modified value

� grey, strikethrough value indicates an unsaved deleted value

� red value indicates a policy is in place

� Where a cell is empty, this means that the settings file does not
contain an entry for the setting.
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The expansion is the text that is added to the name when the rule is
selected.

If you want to allow a name that ends with this text to be an acceptable,
valid name, append a tilde to the expansion text. The tilde is not
appended to the entered text.

If your drawings use or reference BIM intelligent objects, you can
associate an objectstyle with an object by appending the name of the
objectstyle in parentheses to the expansion.

In MicroGDS, the expansion for layer names in multi-user projects can
also use aliases to define the location in which a layer of a particular
name must be stored. For full details, see Chapter 16, Multi-user
projects.
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The description is the text that is displayed in the name assistant dialog
box. It identifies the expansion.

When a name is complete, if there are further applicable rules, the name
can be extended further.

Note that for object names, a single rule selection does not necessarily
correspond to a single facet in the name. The expansion must contain a
colon (:) to finish a facet.
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The layer label is optional and, if defined, is the text that is added to
any new layer that conforms to the Layer Name Assistant. The label
applies only to a the Layer Name Assistant; if added to the Object
Name Assistant, it will be ignored.
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When a user creates a layer or an object, and the name assistants are
both in use, MicroGDS carries out the following procedure:

1 First, MicroGDS reads the associated configuration file and presents
the user with a list of entries defined in the file.

2 Each time the user selects an entry, the expansion text is read from
the configuration file and is added to the Name box.
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If the user expands an entry, MicroGDS reads the condition for the
entry and scans the configuration file for the expansions and lists
their descriptions.

For example:

3 This is repeated until no further name components are applicable.

When a name meets the valid naming rules, the OK button is
enabled.

In the previous example, the rule in the sample layer configuration file
that produced the name shown is:

?–|ELEV~|Elevation

and represents ‘Interior Design, Elevation’.
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The layer configuration file has two sections. The first section defines
the top-level naming structure. Each entry has only two components,
the expansion text and the description.

For example:

|ARCH–|Architectural

|ELEC–|Electrical

|STRU–|Structural

produces three layer entries in the dialog box.

The second section of the file lists the rules that define the possible
expansions of each layer.

ARCH–|WALL~|Walls

ARCH–|FLOOR~|Floors

ELEC–|POWER~|Power installation|Sockets

ELEC–|LIGHT~|Lighting installation|Lighting



Chapter 17: Customizing MicroGDS 391

STRU–|COLUMN~|Columns

STRU–|FOUNDS~|Foundations

????–|ANNO~|Annotation

Selecting, for example, Electrical in the Layer Name dialog box inserts
the expansion text ELEC in the Name box. MicroGDS scans the
configuration file for any matching conditions and lists the descriptions
of each below, in alphabetical order.

In the example file, Annotation appears beneath each main entry. This is
because the condition matches all three main entries.

Selecting Power installation in the list inserts the expansion text
POWER in the Name box and Sockets in the Label box:
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The object configuration file is similar in format to the layer
configuration file. The difference is that object names are facetted, and
the first facet in the object name is the name of the layer on which it is
valid, and the last character of the object name must be a colon (:) if it is
to be treated as completing a facet.

For example:

????–ANNO–????:|anno:~|Annotation

enables the user to create an annotation object on any layer that contains
the text —ANNO—.
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Furthermore, the rules:

ELEC–L*:|LIGHTC:~|Ceiling lights

ELEC–L*:|LIGHTW:~|Wall lights

ELEC–L*:|LIGHTE:~|External lights

mean that all objects on layers beginning with ELEC–L can have a first
facet of LIGHTC:, LIGHTW, or LIGHTE:

The rule:

ELEC–*:LIGHT?:|SPOT:~|Spotlights

means that all objects on layers beginning with ELEC–, which have a
first facet matching LIGHT?, can have a second facet of SPOT,
indicating that it represents a spotlight. The resultant object names
could be LIGHTC:SPOT:, LIGHTW:SPOT:, or LIGHTE:SPOT:

If a rule is defining the names for intelligent objects, you can specify
which objectstyle should be automatically selected on the Properties
window. For example:

IfcWallStandardCase:~(Brick-Cavity-Block)|Standard External Cavity
Wall

means that IfcWallStandardCase: is the object name, then
Brick-Cavity-Block will be set as the objectstyle when the description
Standard External Cavity Wall is selected.
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Before you create or amend a layer or object configuration file, take
some time to familiarize yourself with the format and content of such a
file. You could make a copy of one of the supplied configuration files
before making changes so that you can always go back to the default
version.

Before you set up the name assistants, plan the rules first. Take into
account that the expansion text makes up the name, and that a name can
consist of up to 256 characters.

When you write the rules, the following conventions apply:

� each rule must be written on a separate line

� condition and expansion texts are case sensitive

Although it is clearer to write the rules in a structured way, their order is
not important. MicroGDS displays the matching entries in the dialog
box in alphabetical order based on the description text.
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The object name configuration file takes the layer names defined in the
layer name configuration file into account. Therefore, if you plan to use
both layer and object name assistants the two configuration files should
correspond.
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1 Using a text editor, create or edit the relevant name assistant
configuration file.

2 Save the file to a preferred location, using a name of your choice
and preferably maintaining the cfg extension.
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1 Start MicroGDS and, on the File menu, click Preferences.

MicroGDS displays the Preferences dialog box.

2 Click the Name Assistants tab and specify the name of the
configuration file in the appropriate Configuration File box, and set
the applicability required.

For details of the applicability levels, refer to Help.
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When you start MicroGDS, the initial settings which control the look
and feel are read from two files: a settings file called settings.xml and a
profile file which has a .mprofile extension. Further files may then be
read which may make changes to the appearance and behaviour of
MicroGDS.

The files which affect this behaviour are searched for in a particular
order. Modifications may be made at each stage within the search list:

� MicroGDS first looks for a settings.xml file in the same folder as the
microgds.exe program

This file can alter some of the default values or prevent later settings
files from altering them. In general, this file should not be modified
and any future patches or repairs to your MicroGDS installation are
likely to discard any modifications.

� MicroGDS then looks in your system registry for the location of a
settings.xml file that is shared by all users who log on to your
machine, or by all users across your Windows network domain:
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— if the registry key
HKEY_CURRENT_USER\Software\Policies\Informatix\MicroGDS\11.0

exists and has a String Value of Settings, it should be a string
defining a directory

— if this key does not exist, and if registry key
HKEY_CURRENT_USER\Software\Informatix\MicroGDS\11.0 exists and
has a String Value of Settings, it should be a string defining a
directory

If neither registry value exists, MicroGDS uses a subdirectory called
Informatix\MicroGDS\11.0 in your computer’s special folder
CSIDL_COMMON_APPDATA. On Windows XP, this is typically
C:\Documents and Settings\All Users\Application Data and on
Windows Vista, this is typically C:\ProgramData.

For example:

Note that setting up these registry values are currently the only way
to configure any part of the search list. However, this can be set for
some or all machines by the system administrator using Group
Policies.

When a settings.xml file is found, MicroGDS merges configuration
instructions with the results of applying the previous file.

� MicroGDS then looks for a job-specific settings.xml file in a
CONFIG subdirectory immediately below the folder that contains
the related MicroGDS document.

For example:
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In this example, whenever Document1.MAN, Document2.MAN, or
documentA.MAN is opened in MicroGDS, its document settings are
read from the settings.xml file.

Anyone with write access to a job folder can create a CONFIG
folder. When a job-specific setting is modified in MicroGDS, the
settings.xml file is then automatically created.

� Finally, after MicroGDS has searched all the job-specific
settings.xml files, it looks in your personal directory (for example,
C:\Documents and Settings\Lesley\Application
Data\Informatix\MicroGDS 11.0\settings.xml.
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You can define custom commands that can then be added to MicroGDS.
When you define a new command, you can choose the product and
context in which it should be available. For example, you can specify
that a command is available only in MicroGDS Entry Level and then
only when the current file is single-user and there is an active window
definition. You can also specify that a command is added to a shortcut
menu that appears when you click the right mouse button.
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1 On the File menu, click Preference Files.

2 On the Preference Files Editor, locate the ‘Custom command
definitions’ setting.

You can find this setting under the General category.

3 Click the corresponding cell under the column to customize and then
click 

4 MicroGDS displays the Custom Command Definitions dialog box.

5 Do any of the following:

� To add a new custom command:

a) Click Add.

b) Select the newly added command line, and then click 

MicroGDS displays the Define Custom Command dialog
box.
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� To modify an existing custom command, select the custom
command and then click 

MicroGDS displays the Define Custom Command dialog box.

� To remove a custom command, select the custom command and
then click Remove.

6 If you are adding or modifying a custom command, specify the
command details and click OK.

For details about specifying the command details, refer to Help.

You can add any custom commands that you define to your MicroGDS
menus.
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When you change the axes’ scale on the status toolbar, MicroGDS uses
a scales file to determine the strings and corresponding scales. You
specify the scales file to be used in your File Location preferences.
Scales files have the extension .csv.

MicroGDS supplies a sample scales file called scales.csv. You can
change, rename, and move the file, but we recommend that you retain
the csv extension. If you change the location of the file, ensure that you
redefine the path in your preferences.

Scales files are in the format:

string, scale numerator, scale denominator

For example:

1:1,1,1

1:20,1,20

1:75,1,75

”1”” = 1”””,1,1

”3”” = 1‘”, 1, 4

”1”” = 1‘”, 1, 12

Note that MicroGDS uses the scales file in a number of other places.
For example, on the Photo Transform dialog box when you construct a
photo from a 2D view or a 3D parallel view. For details about working
with photos, refer to Help.

For more details on the format of the file, refer to Help.
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When you rotate the axes, graphics are drawn using the current axes’
rotation. You can change the angle of the axes, using the Angle box on
the status toolbar or the Axes Angle command, so that all new graphics
are aligned with the new angle.

When you set the angle, MicroGDS uses an angles file to determine the
strings and corresponding angles. You specify the angles file to be used
in your preferences. Angles files have the extension .csv.

MicroGDS supplies a sample angles file called angles.csv. You can
change, rename, and move the file, but you must retain the csv
extension for the file to be recognized. If you change the location of the
file, ensure that you redefine the path in your preferences.

Angles files are in the format:

string, angle value

For example:

–90,–90d

–60,–60d

–45,–45d

–30,–30d

0,0d

30,30d

45,45d

60,60d

Note that MicroGDS uses the angles file in a number of other places.
For example, when you define snap guide angles on the Snapping tab of
the Preferences dialog box.

For more details on the format of the file, refer to Help.
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The first time that you select a print layout view for a window
definition, MicroGDS displays the Page Setup dialog box for you to set
your paper size requirements. MicroGDS uses a paper sizes file to
determine the paper names and corresponding sizes. You specify the
paper sizes file to be used in your File Location preferences. Paper sizes
files have the extension .csv.
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MicroGDS supplies a sample paper sizes file called ‘paper sizes.csv’.
You can change, rename, and move the file, but we recommend that you
retain the csv extension. If you change the location of the paper sizes
file, ensure that you redefine the path in your preferences.

Paper sizes files are in the format:

name of paper, unit of measurement, paper width and height, paper
margins

ISO A4 (297 by 210 mm),mm,297,210,10,10,10,10
ISO A3 (420 by 297 mm),mm,420,297,10,10,10,10
ISO A2 (594 by 420 mm),mm,594,420,10,10,10,10
ISO A1 (841 by 594 mm),mm,841,594,10,10,10,10,DEFAULT
”ANSI A (Letter, 11 by 8.5 inches)”,inches,11,8.5,0.5,0.5,0.5,0.5
ANSI B (17 by 11 inches),inches,17,11,0.5,0.5,0.5,0.5
ANSI C (22 by 17 inches),inches,22,17,0.5,0.5,0.5,0.5

and so on.

The default paper size initially selected in the dialog box is indicated by
the word DEFAULT at the end of the definition

For more details on the format of the file, refer to Help.

When you have assigned a paper sizes file to a window definition,
MicroGDS uses the paper definition that you set up when you next
switch to print layout. The paper definition is saved with the window
definition when you save the document.

For details about print layout views, see Chapter 2, Exploring
MicroGDS.
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A number of sample Visual Basic and .NET programs are supplied with
MicroGDS. You can use them as they are, you can amend or extend
them, or you can simply look at them to give you ideas for
programming using Visual Basic or Visual Studio .NET.

You can access the programs from your MicroGDS Applications menu
on the Start menu. Each program has a corresponding document that
tells you how to use the program.
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If you use any programs regularly, you can add them to a new menu so
that they are available from the MicroGDS menu bar. Details about
adding and removing menus and commands are given in Defining
custom commands on page 395.

The sample Visual Basic programs are not a supported part of the
MicroGDS system.
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MicroGDS provides 3D commands that you can use to construct and
edit clumps. In MicroGDS Collaboration, you have access to many
more advanced 3D facilities to create and modify clumps.

This chapter shows some of the different types of clumps that you can
construct using the advanced 3D commands. Step-by-step instructions
on how to construct clumps and details about each of the clump
commands are given in Help.

For information about working with clumps and details on the 3D
facilities that are available in all MicroGDS products, see Chapter 9,
Working in 3D in Part One: Working with MicroGDS 11. You can also
refer to Help.



404 Using MicroGDS 11
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MicroGDS Collaboration offers a number of additional methods for you
to create clumps. You can:

� automatically construct simple 3D clumps (using the Solid,
Construct commands)

� create clumps by revolving graphics using specified angles and
positions (using the Solid, Construct commands)

� use existing line primitives to create mesh clumps with surfaces
(using the Solid Patch and Solid Rule Surface commands)
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MicroGDS Collaboration provides commands to generate cones,
cuboids, cylinders, and spheres.
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When you create a cone, cuboid, or cylinder, you can specify the
dimensions of the cuboid by:

� clicking the positions in the window

� typing the coordinates at the prompt bar

� or pressing Enter to enter the sizes in a dialog box

Note that X, Y and Z sizes in the dialog boxes take precedence over
snaps and coordinates. If you do not want to use exact dimensions,
ensure that the sizes are set to ‘Use Snaps’ in the dialog box.

When you create a sphere, you enter the radius for the sphere and then
place the sphere by clicking in the window or typing coordinates.

For full details on generating simple 3D graphics, refer to Help.
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As an alternative to creating clumps using the Complete Revolve
command, you can also revolve graphics:

� from one angle through to another

.���	��	�*��*��� G�*��*�����	�
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� or, from a specified position, through a specified angle about the Y
axis
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8-°
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The angle through which the graphics are revolved is measured from
the X axis.

The graphics you revolve should be in the XY plane and must not cross
the Y axis.
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With all revolve commands:

� each closed line primitive forms a solid clump

� each open line primitive forms a mesh clump

By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.

Except when revolving through 360°, if you revolve multiple, closed
line primitives that are nested, holes are created in the enclosing clump.

�
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You can construct a mesh clump from existing line primitives. You can:

� create a surface between two line primitives
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By default, MicroGDS creates a patched surface with evenly
distributed quadrilateral faces (as shown above). If preferred, you
can choose to create long quadrilateral faces instead.

If the line primitives are closed, the position at which you select
each primitive will define the start point of the edge. For example, if
the primitives are one above the other, select them by points that are
directly one above the other to avoid creating a twisted surface.

If the line primitives are open, MicroGDS creates the surface rule by
drawing between the start points of each line. The direction of open
line primitives is therefore important.
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� or, create a surface from three or four bounding line primitives
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Lines can be curved and they can consist of more than one line
segment.

The lines must be touching—forming a closed boundary—but they
must not be sides of a closed line primitive (for example, as created
by the Rectangle command).

If four lines were selected, a quad-face surface is generated with
points interpolated between opposite pairs of boundary lines; if three
lines were selected, a triangular-face surface is generated with points
interpolated evenly between the three boundary lines.

!�������	#�&��
MicroGDS Collaboration offers a number of additional commands for
you to edit existing clumps. You can:

� use Boolean commands to alter solid clumps

� add and edit clump faces

� change the geometry of clumps for import and export
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The Boolean operations enable you to add or subtract volumes from
clumps. The volume is the space occupied by the content of a 3D object
or primitive. You can use the Volume command on the Query menu to
measure the volume of a clump. For more details about the query
commands, see Chapter 13, Getting information.

Using the Boolean operations, you can:

� add or subtract a number of clumps from another clump (the
workpiece)

� subtract or intersect a clump with the clumps currently selected
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� check a selection of clumps for clashes, and create new graphics
along their clash lines

� create pockets in a clump, and profiles from a clump

� punch holes in a clump, and carve a shape from a clump

� slice clumps along the XY plane, and choose to remove either the
section above or below the plane

� slice clumps between the XY plane, and remove both the sections
above and below the plane

In Boolean operations, the workpiece is the clump on which
modifications will be made. The workpiece must be a solid clump. The
selection can be one or more solid clumps that are used when making
those modifications.
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When you edit the workpiece, the clumps that are being added or
subtracted must intersect the workpiece. You can:

� add solid clumps to the workpiece
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� or, subtract solid clumps from the workpiece
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By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.
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Materials are used when you render 3D graphics in MicroGDS
Collaboration. A clump is ‘made of’ a material, and can also have a
different material assigned to each of its faces. For example, a cube can
be made of the material ‘wood’, and have the material ‘yellow paint’ on
some faces.

Materials in MicroGDS Collaboration have several characteristics, such
as colour, pattern, reflectance, and transparency. By using different
materials, you can create rendered scenes that are much clearer.

Materials are also used when you view a drawing in a 3D shaded view.
Note that, for materials created in MicroGDS Collaboration, many
material attributes are not used in a shaded view. For details about 3D
views, see Chapter 9, Working in 3D in Part One: Working with
MicroGDS 11.

This chapter describes the materials that you can create in MicroGDS
Collaboration. For details on how to change, modify, and delete
materials, see Chapter 11, Working with materials in Part One: Working
with MicroGDS 11. You can also refer to Help.
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Shaders can be ‘solid’ or ‘wrapped’:

� solid shaders create a constant effect over a surface and through a
solid

� wrapped shaders create an effect that is dependent on the surface
position in texture space.

For more details on texture spaces, see Texture space shaders on
page 477.

Some shaders also allow you to use image files in a material to obtain
specific textured and patterned effects. For example, with the Wrapped
Image colour shader, images are wrapped around the surfaces that are
assigned the material:
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When you choose a material that uses an image, by default MicroGDS
looks for the image in the Textures folder specified in your Renderer
preferences. You can also create Renderer aliases to point to additional
locations. For details about creating renderer aliases, see Chapter 17,
Customizing MicroGDS in Part One: Working with MicroGDS 11.

Some examples of different materials are shown below. The first
example shows the default rendered image, as it would appear before
any materials are added. In the remaining illustrations, a Wrapped Brick
displacement material is assigned to the base, and a variety of effects, in
turn, are assigned to the vase.
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The following sections give brief descriptions of each shader. For
information on the associated attributes, refer to Help.
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Every surface has a colour; a colour shader defines the colour of a
surface at any point in space. It can range in complexity from a simple
colour to a complex surface pattern. Tiled bitmap images can be applied
to define the colour; these are ideal for surfaces such as brickwork, tiles,
or carpeting.

The following solid colour shaders are available.

Birch A pattern that resembles birch wood.

Blue Marble A blue marble pattern.

Cherry A pattern that resembles cherry wood.

Chrome Simple chrome-like reflections.

Cubes A three-dimensional lattice of cubes with
alternating colours.

Fleck A pattern which has a base colour with coloured
flecks as seen in some plastics, composite
materials, or tiles.
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Granite A pattern that resembles granite.

Height Band A pattern of colours specified by heights on the
object’s surface.

Maple A pattern that resembles maple wood.

Marble A veined marble pattern.

Oak A pattern that resembles oak wood.

Paving A pattern that resembles crazy paving.

Pine A pattern that resembles pine wood.

Plain A plain, uniform colour (the default).

Simple Wood A simple wood pattern. The wood grain is based
on a tree trunk centred on a given axis with
concentric rings of light and dark wood colours.

Solid Clouds A pattern of clouds.

Solid Polka A pattern of spheres embedded in a plain matrix.
Slices through the matrix have a polka-dot
appearance.

Turbulent A pattern that simulates the variations in a
turbulent medium, such as smoke or patchy fog.

Wood A wood pattern. The wood is based on a tree
trunk centred on a specified axis, the direction of
which is aligned with the object axes, with
concentric rings of light and dark wood, and
grain.

The following wrapped colour shaders are available.

Wrapped Birch
Floor

A wooden plank pattern in a finish that resembles
birch wood.

Wrapped Brick A simple brick pattern.

Wrapped Brick
Bonds

A complex brick pattern.

Wrapped Checker A chequer-board pattern using two alternate
colours.

Wrapped Colour
Blend

A pattern blending two wrapped images or two
colours together.
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Wrapped Cherry
Floor

A wooden plank pattern in a finish that resembles
cherry wood.

Wrapped Diagonal A diagonal stripe pattern using background and
stripe colours.

Wrapped Filtered
Image

A wrapped texture, filtered with a specified
colour, providing image colour mapping.

Wrapped Grid A grid pattern using background and grid colours.

Wrapped Image A wrapped texture providing image colour
mapping.

Wrapped Maple
Floor

A wooden plank pattern in a finish that resembles
maple wood.

Wrapped Oak
Floor

A wooden plank pattern in a finish that resembles
oak wood.

Wrapped Pine
Floor

A wooden plank pattern in a finish that resembles
pine wood.

Wrapped Polka A texture giving a polka-dot pattern created by
setting a grid of circles of one colour against a
background of another colour.

Wrapped Random A wrapped texture giving a random pattern using
two colours.

Wrapped Roof
Tiles

A sophisticated roof tile pattern.

Wrapped S Stripe A stripe pattern in constant s in texture space.

Wrapped T Stripe A stripe pattern in constant t in texture space.

Wrapped Textured
Brick

A sophisticated brick pattern. Each brick has a
base colour randomly assigned, and is textured
using a variation in colour around the base colour.

Wrapped Wood
Floor

A pattern that simulates wooden-plank style
patterns, such as floorboards, based on a
replication scheme.



511

����"

Numbers
2D switching views, 221

3 point projections, 228

3D

coordinates, 134

line of sight, 229

projections, 228

switching views, 221

XY plane, 230

3DS files, 328

A
acknowledgements, 508

adding

assembly objects, 79

attributes, 322

charstyles, 195

layers, 114

lightstyles, 260, 454

linestyles, 158

materials, 276, 479, 482

menus, 380

mnemonics, 313

multi-user projects, 346

objects, 68

schemas, 315

shortcut keys, 379

text, 208

toolbars, 374, 375

advanced lighting, 426

AIF files, 328

aliases, 27
default, 355
layer name assistant, 121
overriding, 359
renderer, 439

aligning
text, 213
views, 149

altering graphics, 91
ambient lights, 257, 449
angle, axes, 148
angles file, customizing, 397
area lights, 449
assembly objects

about, 78
closing, 80
creating, 79
dissolving, 80
opening, 80

assigning
attributes, 319
shortcut keys, 379

assistl.cfg, 388
assisto.cfg, 388
attributes, 309

adding, 322
assigning values, 319
copy link, 324
copying, 324
filtering objects, 325
hidden, 314
layer level, 313
mnemonics, 313
object level, 313
primitive level, 313
reference level, 313
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switch to XY plane, 230
switching, 45
toggling 2D and 3D, 221
wireline, 241

views, multiple, printing, 293
views, single, printing, 291
visible phases, 107
Visual Basic, sample programs, 398

W
weather based rendering, 434
website, 3
wheel mouse support, 48
wildcards, 72
window

label, 105
layout, 11
MicroGDS, 10

window definitions
closing, 40
copying layers into, 117
creating, 38
exporting, 331
in MAN files, 24
multi-user projects, 341
opening, 39
overriding aliases, 359
principal window, 40

publishing, 332
renaming, 40
saving, 358

Window Editor, 102
window extent, 42
window photo primitives, 58, 59
window quality, 45
window-level attributes, 313
windows, resizing and docking, 11
wireline view, 241
WN# files, 359
WN$ files, 359
Working, project template, 344
wrapped shaders

colour, 467
displacement, 476
reflectance, 472
transparency, 473

X
x, y, z buttons, 142
XY plane

3D view, 230
Dot snapcode, 129

Z
Z=0 button, 18
zooming, 49

3D views, 222


